DIGITAL VOICE
RECORDER

DM-5
DM-3

DETAILED
INSTRUCTIONS

Thank you for purchasing an Olympus
Digital Voice Recorder.
Please read these instructions for information
about using the product correctly and safely.
Keep the instructions handy for future reference.

————————————————————————————————————————————
To ensure successful recordings, we recommend that
you test the record function and volume before use.

Register your product on www.olympus-consumer.com/register
and get additional benefits from Olympus! m



Introduction

+ The contents of this document may be changed in the future without advanced notice.
Contact our Customer Support Center for the latest information relating to product names
and model numbers.

« The screen and recorder illustrations shown in this manual were produced during the
development stages and may differ from the actual product. The utmost care has been
taken to ensure the integrity of the contents of this document. In the unlikely event that
a questionable item, error, or omission is found, please contact our Customer Support
Center.

« Any liability for passive damages or damage of any kind occurred due to data loss incurred
by a defect of the product, repair performed by the third party other than Olympus or an
Olympus authorized service station, or any other reason is excluded.

Trademarks and registered trademarks

« IBM and PC/AT are the trademarks or registered trademarks of International Business
Machines Corporation.

+ Microsoft, Windows and Windows Media are registered trademarks of Microsoft
Corporation.

+ Macintosh and iTunes are the trademarks of Apple Inc.

+ microSD and microSDHC are the trademarks of SD Card Association.

» MPEG Layer-3 audio coding technology licensed from Fraunhofer IS and Thomson.

+ EUPHONY MOBILE™ is a trademark of DiMAGIC Corporation.

+ DVM™ s a trademark of DiIMAGIC Corporation.

+ The product was developed based on noise-canceling technology under license from NEC
Corporation.

+ Nuance, the Nuance logo, RealSpeak and VoCon are trademarks or registered trademarks of
Nuance Communications, Inc. or its subsidiaries in the United States and/or other countries.

+ The Daisy OK mark is a trademark of the Daisy Consortium.

Other product and brand names mentioned herein may be the trademarks or registered

trademarks of their respective owners.
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Safety precautions

Before using your new recorder, read this
manual carefully to ensure that you know
how to operate it safely and correctly.
Keep this manual in an easily accessible
location for future reference.

» The warning symbols indicate important
safety related information. To protect
yourself and others from personal injury or
damage to property, it is essential that you
always read the warnings and information
provided.

&Danger

If the product is used without
observing the information given
under this symbol, serious injury
or death may result.

&Warning

If the product is used without
observing the information given
under this symbol, injury or death
may result.

& Caution

If the product is used without
observing the information
given under this symbol, minor
personal injury, damage to the
equipment, or loss of valuable
data may result.

Caution for usage environment

To protect the high-precision
technology contained in this
product, never leave the recorder
in the places listed below, no
matter if in use or storage:

Places where temperatures and/or
humidity are high or go through
extreme changes. Direct sunlight,
beaches, locked cars, or near other
heat sources (stove, radiator, etc.) or
humidifiers.

In sandy or dusty environments.

Near flammable items or explosives.

In wet places, such as bathrooms

or in the rain. When using products

with weatherproof designs, read their
manuals as well.

In places prone to strong vibrations.
Never drop the recorder or
subject it to severe shocks or
vibrations.

The recorder may malfunction
ifitis used in a location where
itis subject to a magnetic/
electromagnetic field, radio
waves, or high voltage, such

as near a TV set, microwave,
video game, loud speakers,
large monitor unit, TV/radio
tower, or transmission towers.
In such cases, turn the recorder
off and on again before further
operation.

Avoid recording or playing back
near cellular phones or other
wireless equipment, as they may
cause interference and noise.

If you experience noise, move
to another place, or move the
recorder further away from such
equipment.



« Do not use organic solvents such
as alcohol and lacquer thinner to
clean the unit.

<Warning regarding data loss>

Recorded content in memory may

be destroyed or erased by operating

mistakes, unit malfunction, or during

repair work.

Itis recommended to back up and save

important content to other media such as

a computer hard disk.

Any liability for passive damages or

damage of any kind occurred due to data

loss incurred by a defect of the product,
repair performed by the third party other
than Olympus or an Olympus authorized
service station, or any other reasons is
excluded from the Olympus’s liability.

Handling the recorder

AWarning:

+ Do notuse the recorder near
flammable or explosive gases.
« Keep young children and infants
away from the recorder.
Always use and store the recorder out of
the reach of young children and infants
to prevent the following dangerous
situations which could cause serious
injury:
(D Becoming entangled in the recorder
strap, causing strangulation.
(@ Accidentally swallowing the battery,
cards or other small parts.
(@ Accidentally being injured by the
moving parts of the recorder.
« Do notuse orstore the recorder
in dusty or humid places.
» Do notdisassemble, repair or
modify the unit yourself.

Safety precautions

Use microSD/microSDHC memory
cards only. Never use other types
of cards.

Ifyouaccidently insertanother type of card
into the recorder, contact an authorized
distributor or service center. Do not try to
remove the card by force.

Do not operate the unit while
operating a vehicle (such as a
bicycle, motorcycle, or go-cart).

Caution:

Stop using the recorder
immediately if you notice any
unusual odors, noise, or smoke
around it.

Never remove the batteries with bare
hands, which may cause a fire or burn your
hands.

Be careful with the strap.

Be careful with the strap when you carry
the recorder. It could easily catch on stray
objects and cause serious damage.

Do not leave the recorder in

places where it may be subject to

extremely high temperatures.
Doing so may cause parts to deteriorate
and, in some circumstances, cause the
recorder to catch fire. Do not use the
charger or AC adapter if it is covered (such
asablanket). This could cause overheating,
resulting in fire.

Handle the recorder with care to

avoid getting a low-temperature

burn.

« When the recorder contains metal
parts, overheating can result in a low-
temperature burn. Pay attention to the
following:

« When used for a long period, the
recorder will get hot. If you hold on
to the recorder in this state, a low-
temperature burn may be caused.



In places subject to extremely cold
temperatures, the temperature of the
recorder’s body may be lower than
the environmental temperature. If
possible, wear gloves when handling
the recorder in cold temperatures.
Do not touch the metallic parts of
the recorder for a long period of
time at low temperatures.
This may damage your skin. At low
temperatures, handle the recorder while
wearing gloves.

Battery handling precautions

Follow these important guidelines
to prevent batteries from leaking,
overheating, burning, exploding, or
causing electrical shocks or burns.

Danger:

The recorder uses a lithium ion
battery specified by Olympus.
Charge the battery with the
specified AC adapter or charger.
Do not use any other AC adapters
or chargers.

Batteries should never be
exposed to flame, heated, short-
circuited or disassembled.
Never heat or incinerate
batteries.

Take precautions when carrying
or storing batteries to prevent
them from coming into contact
with any metal objects such as
jewelry, pins, fasteners, etc.
Never store batteries where
they will be exposed to direct
sunlight, or subjected to high
temperatures in a hot vehicle,
near a heat source, etc.

Safety precautions

To prevent causing battery leaks
or damaging their terminals,
carefully follow all instructions
regarding the use of batteries.
Never attempt to disassemble a
battery or modify it in any way,
solder, etc.
Do not connect the battery
directly to a power outlet
or acigarette lighter of an
automobile.
If battery fluid gets into your
eyes, flush your eyes immediately
with clear, cold running water
and seek medical attention
immediately.

Warning:
Keep batteries dry at all times.
If rechargeable batteries have
not been recharged within the
specified time, stop charging
them and do not use them.
Do not use a battery ifitis
cracked or broken.
Never subject batteries to strong
shocks or continuous vibration.
If a battery leaks, becomes
discolored or deformed, or
becomes abnormal in any other
way during operation, stop using
the recorder.
If a battery leaks fluid onto your
clothing or skin, remove the
clothing and flush the affected
area with clean, running cold
water immediately. If the fluid
burns your skin, seek medical
attention immediately.
Keep battery out of the reach of
children.



If you notice anything unusual
when using this product such as
abnormal noise, heat, smoke, or a
burning odor:

(D remove the battery immediately while
being careful not to burn yourself,
and;

@call your dealer or local Olympus
representative for service.

Caution:

Please recycle batteries to help
save our planet’s resources. When
you throw away dead batteries,
be sure to cover their terminals
and always observe local laws and
regulations.

Always charge a battery when
using it for the first time, or if

it has not been used foralong
period.

Rechargeable battery have
limited lifetime. When the
operating time becomes shorter
even if the rechargeable battery
is fully charged under the
specified condition, replace it
with a new one.

The battery may become hot
during prolonged use. To avoid
minor burns, do not remove
itimmediately after using the
recorder.

Safety precautions

ACadapter

A Danger:

Be sure to use the AC adapter
with the proper voltage (AC 100 -
240 V). Using it with other voltage
levels may cause fire, explosion,
overheating, electric shock or
injury.
For safety, be sure to unplug
the AC adapter from the outlet
before performing maintenance
or cleaning. Also, never plug in or
disconnect the power plug with a
wet hand. This may cause electric
shock or injury.

Warning:
Do not attempt to disassemble,
repair or modify the AC adapter
in any way.
Keep foreign objects including
water, metal, or flammable
substances from getting inside
the product.
Do not moisten the AC adapter or
touch it with a wet hand.
Do not use the AC adapterin
the vicinity of flammable gas
(including gasoline, benzine and
lacquer thinner).

In case

...theinternal parts of the ACadapter

are exposed because it has been
dropped or otherwise damaged:

... the AC adapter is dropped

in water, or if water, metal
flammable substances or other
foreign objects get inside it:



.. you notice anything unusual

when using the AC adapter such

as abnormal noise, heat, smoke,

or a burning odor:

(D do not touch any of the exposed parts;

(@immediately disconnect the power
supply plug from the power outlet,
and;

@ call your dealer or local Olympus
representative for servicing. Continued
use of the AC adapter under these
circumstances could result in electric
shock, fire or injury.

Caution:

Do not use the AC adapter if the
power plug is damaged or the
plug is not completely connected
to the outlet. This may cause fire,
overheating, electric shock, short
circuit or damage.

Unplug the AC adapter from AC
outlet when not using. If this
precaution is not followed, fire,
overheating or electric shock may
occur.

Make sure to hold the plug when
removing the power plug from
the outlet. Do not bend the

cord excessively or put a heavy
object on it. This may cause fire,
overheating, electric shock or
damage.

If something appears to be wrong
with the AC adapter, unplug the
AC adapter from the outlet and
consult your nearest service
center. Using the AC adapter may
cause fire, overheating, electric
shock or injury.

Safety precautions

Do not use or keep the AC adapter
in very hot places, such as in
direct sunlight, in a closed car

on a sunny day, near a heater,

on an electric carpet, etc. Do not
use the AC adapter if something
is covering it (such as a blanket).
This may cause fire, explosion,
leakage or overheating.

LCD monitor

The LCD used for the monitor

is made with high-precision
technology. However, black
spots or bright spots of light may
appear constantly on the LCD
Monitor. Due to its characteristics
or the angle at which you are
viewing the monitor, the spot
may not be uniform in color

and brightness. This is not a
malfunction.
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Getting started

Main features

Thisrecorder cantagrecorded files
orfiles transferred fromapersonal
computer with keywords to
manage a file database (= P.75).
Itis possible to search for files by file date
or keyword (= P.53).

It features a scheduling function
(= P.96).

The settings and functions of this
recorder can be controlled using
speech recognition (= P.107) (For
DM-5).

By connecting a digital camera,
you can import and view images
(== P.103) (For DM-5).

This recorder can import text
data and read it aloud (= P.158)
(For DM-5).

Supports the linear PCM format,
which is capable of recording
sound quality equivalent to or
surpassing CD-level.

Capable of realistically recording various
different sound sources.High resolution
recording at a high sampling frequency
equivalent or superior to that of a music
CD (Sampling frequency 44.1 kHz, Bit
count 16bit) is possible (== P.67).
Supports a wide range of
recording formats. Can handle
the MP3 format (MPEG-1 Audio
Layer 3), and the Windows Media
Audio (WMA) format (== P.67).

This device can save files in a highly
compressed manner, thereby allowing
for extended recording times. In
addition, when connected to an external
device, the recorder can encode
incoming analog audio signals without a
PC (= P.45).

Supports high capacity recording
media.

Besides the 8GB (DM-5) or 4GB
(DM-3) built-in memory, you can
also record onto a commercially-
available microSD card (= P.30).
You can playback WAV, WMA, and
MP3 format files transferred from
a computer in addition to files
recorded by the device itself.

You can enjoy music at any time.

It has a built-in Variable Control
Voice Actuator (VCVA) function
(= P.69).

The Low Cut Filter minimizes

air conditioner noise and other
similar noises while recording

(= P.69).

The recording level can be
adjusted automatically or
manually (= P.67).

A Noise Cancel function (== P.71)
and a Voice Filter function

(= P.71) cut noise and enable
clear audio playback.

For WMA-format recording, you
can select one of 6 recording
modes such as stereo or monaural
(= P.67).

Has built in recording scene
setting («= P.81) and playback
scene setting (= P.85) functions
to register the recording or
playback sound quality or mode
according to different usages.



You can move or copy files
between the built-in memory
and microSD card, and within the
folders in the memory (== P.91).
You can divide files (= P.93),

or delete part of a file (== P.64)
recorded in PCM format in this
recorder.

Ithasa2.2inch TFT color LCD panel
(= P.15).

It features various repeat
functions («== P.72, P.73).

Index mark features allow you

to quickly find desired locations
(= P.51).

The playback speed can be
controlled as preferred (= P.73).
The guidance feature (in English
and other languages) gives
audio notification of operating
conditions. Various functions can
be operated easily. Thereis also a
function to read file information
aloud (= P.85) (For DM-5).

You may assign your own names
to folders (r== P.70).

Timer recording («= P.81) and
Alarm playback features (x= P.87)
enable automatic recording and
playing at a set time.

A directional microphone feature
has been included that allows
switching between broad stereo
recording and recording with

a highly directional quality

(v= P.68).

Main features

EUPHONY MOBILE has been
included to produce a natural,
realistic experience without
degrading sound quality (v= P.71).
Fast forward and rewind are
possible at set intervals (== P.73).

Comes with “Olympus Sonority”
software for Windows and

Macintosh (= P.109).

If you transfer voice files recorded with
the recorder to a PC, you can easily
playback, organize, and edit the files.
You can perform waveform editing, file
joining, and file splitting.

The “Olympus Sonority” can

be upgraded to a “Olympus
Sonority”, which is equipped with
enhanced functionality (Option)
(= P.136).

In addition to the “Olympus Sonority”
functions, editing of MP3 files and
creation of music CDs can be performed.
This recorder is compatible

with USB 2.0, enabling fast data
transfer to a computer.

It has a USB charging function

(= P.23).

It is compatible with DAISY

(== P.132) (For DM-5).

DAISY files can be transferred from the
“Olympus Sonority” software and played
from this recorder.

@ Itis compatible with Audio Book

(= P.157).

sainjeay urey
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@ Itis compatible with Podcasting
(= P.127).
If favorite Podcast URLs are registered
in the “Olympus Sonority”, the latest
broadcasting content will be received
automatically. Open the [Podcast] folder
on the recorder to quickly listen to the
program (file) transferred from the
“Olympus Sonority”.

® Compatible with Audible
broadcasting (= P.159).

Main features



Identification of parts

@ﬂ$—®

@ MIC (Microphone) jack

(2 Built-in stereo microphone

(3 LED indicator light

(@ VOICE button (For DM-5)
HOME button (For DM-3)

(5 POWER/HOLD switch
(® Strap hole

(@ Display(LCD Panel)
REC (Record) button
(@ »» button

» OK button (Play/Set)

@D Fn button (F1/F2/F3)
{2 STOP button

@3 + button

¢« button

@5 - button

Built-in speaker

{0 EAR (Earphone) jack
Card cover

Battery cover

(20 USB connector

@) Power jack
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[Home] menu display ] o 11: 12 ]
Whenthe poweristurned on,the[Home] menuisdisplayed. 0
The [Home] menu provides links to various functions.

For more details about these functions, refer to their
respective page numbers below.

Identification of parts

Menu

Function

\!} Recorder

Records files to one of five voice recording folders (Folder
A through Folder E) (== P.39). Recorded files can be tagged
with keywords so that the files can be managed in a database
(v= P.75).

n Music

Manages music files imported from music software such as
Windows Media Player and iTunes. This recorder can be used
as a music player (== P.138, P.150).

@ Podcast

Manages podcasts transferred to this recorder using the
supplied “Olympus Sonority” software (5= P.127).

m Audiobooks

Manages DAISY books (= P.132) (For DM-5) and Audio Books
(= P.157) transferred to this recorder using the supplied
“Olympus Sonority” software. Also manages text files (5= P.158)
(For DM-5) directly transferred to this recorder.

m Picture

You can import images by connecting a digital camera to this
recorder (== P.103) (For DM-5).

Audio Diary

Registers and manages schedules («= P.96).

?T Preferences

Sets various functions of the recorder.




[Recorder] mode display

Recording display

0408

3w28.5bs

INDEX

@ File name
@ Folder name
© Current file number/
Total number of recorded files in
thellist
O Recorder status indicator
O Level meter
@ Index indicator
@ Function guide indicator
© Current time
(9] Recording mode indicator
@ Elapsed recording time
@® Remaining recording time

[(RI[@@] Memory indicator
[@] Timer indicator

Icon display (For all modes)

Identification of parts

Playback display

syed jo uonyedyiuapy i

© File name

@ Folder name/Keyword/Date

© Current file number/Total number
of recorded files in the list

(4) Playback position bar indicator

© Recorder status indicator

0 Index indicator/File information
indicator

@ Function guide indicator

@ Current time

O File format

@ File length

@ Elapsed playback time

[4»] Zoom Mic indicator
[§f3] Noise Cancel indicator
[§§3] Voice Filter indicator
[/A\w] EUPHONY indicator
[ D] Repeat indicator
[&3] Random indicator
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[Music] [Podcast] mode display

Music playback display

© File name

@ Search category

© Current file number/
Total number of recorded files in
the list

(4] Playback position bar indicator

© Recorder status indicator

O Information display area

@ Function guide indicator

© Current time

O File format

@ Filelength

@® Elapsed playback time

Identification of parts

Podcast playback display

? 29999

? .

© File name

@ Program name

© Current file number/
Total number of recorded files in
the folder

(4) Playback position bar indicator

© Recorder status indicator

O Information display area

@ Function guide indicator

© Current time

O File format

@ File length

® Elapsed playback time



[Audiobooks] mode display

Identification of parts

DAISY playback display (For DM-5) Audio book playback display

@ Table of contents indicator

@ Contents name

© Playback position bar indicator
O Recorder status indicator

@ Text display area

O Function guide indicator

@ Current time

O File format

OFilelength

@ Elapsed playback time

? ?299%¢

© The Little
mx 2.0 A, 2

1
INDEX MENL

?

© File name

@ Contents name

© Current file number/Total number
of recorded files in the folder

O Playback position bar indicator

© Recorder status indicator

O Information display area

@ Function guide indicator

© Current time

O File format

@ File length

@ Elapsed playback time

syed jo uonyedyiuapy i
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[Audiobooks] mode display

Text playback display (For DM-5)

© File name

@ Folder name

© Current file number/Total number
of recorded files in the folder

O Playback position bar indicator

© Recorder status indicator

@ Text display area

@ Function guide indicator

© Current time

O File format

@ File length

@ Elapsed playback time

Identification of parts

[Audio Diary] mode display

Calendar display

SunMon TueWed Thu
01 02 03 04
09 10 11

Wed
HOME MTH

@ Title indicator

@ Year and month

© Calendar display area

O Schedule display area for
selected day

@ Function guide indicator

O Current time

@ Current day

@ Day registered in schedule



Power supply

|nserting the battery « Be careful of the direction of the
battery when inserting it.

This recorder uses a lithium ion battery « The supplied rechargeable battery

specified by Olympus (LI-50B). Do not use is not fully charged. Before using the

any other type of battery. unit the first time or after long periods

of disuse, it is recommended that you

charge it until full (== P.22).
n While pushing down on the
grooves using both thumbs, slide
the battery cover in the direction

indicated by the arrow. Close the battery cover by sliding

all the way in direction while
pushing down in direction ®.

With the back label of the battery
facing up, line up the terminals of
the recorder and battery. Insert the
battery by sliding in direction ® m
while pushing down in direction ®).

+ Besuretostop therecorder before replacing
the battery. Unloading the battery while the
recorder is in use may corrupt the file. If you
arerecordinginto afile and the battery runs
out, you will lose your currently recorded file
because the file header will not be able to
close. Itis crucial to change the battery once
you see only one Hash mark in the battery
indicator.

« The battery cover is not attached at the
time of purchase.

« Do not use too much force when inserting
the battery. Use only the method listed
above to install and remove the battery.
Otherwise, damage may occur.

Kjddns samog i
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« If it takes longer than 15 minute to replace
the dead battery or if you take the battery
inand out repeatedly at shortintervals, you
may have to reset the time when you have
loaded fresh batteries (. P.28).

» Remove the battery if you are not going to
use the recorder for an extended period of
time.

+ When playing a voice/music file, the
recorder may be reset due to the
reduction of the voltage output of the
battery depending on the volume level
even if [f#4]] is displayed in the battery
indicator. In this case, lower the volume of
the recorder.

+ When replacing rechargeable battery, be
sure to use lithium ion battery (LI-50B)
specified by Olympus. The use of other
manufacturers' products can damage the
recorder and should be avoided.

Power supply

Charge the battery

Lithium ion battery is self
discharging. After unpacking
this product, charge the supplied
lithium ion battery before using
the recorder for the first time.

Charging using ACadapter

Theincluded ACadapter (A515) can be connected
to this recorder for charging. We recommend
using the AC adapter when recording or
operating the recorder for long periods.

n Connect the ACadapterin to an
ACoutlet.

Connect the AC adapter to the
recorder.

« Charging has started when LED
indicator lightis orange and the battery
indicator on the display changes to the
charging indicator.




+ Do not put in or take out the battery or AC
adapter when the recorder power is on or
when this recorder is connected to another
device. It may cause problems with the
values and functions set in the recorder.

+ Thecharger can be used within the range of
AC 100V to AC 240V (50/60 Hz).When using
the charger abroad, you may need a plug
adapter to convert the plug to the shape of
the AC wall outlet. For details, ask at your
local electrical shop or travel agent.

+ Donotusetravel voltage converters as they
could damage your charger.

Power supply

Charging by connecting toa
computer via USB

You can charge the battery by connecting
to a PC's USB port. When charging, be sure
to correctly place the rechargeable battery
(supplied) into the recorder (== P.21).

I Boot the PC.

Connect the USB connection
cable to the USB port of the PC.

While the recorder is during stop
mode or hold mode, connect

the USB cable to the connecting

terminal on the bottom of this

recorder.

« Charging has started when LED
indicator lightis orange and the battery
indicator on the display changes to the
charging indicator.

Kjddns samog i
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Connect to the USB connecting AC
adapter (optional) to charge

It can be charged by connecting to the USB
connecting AC adapter (A514) (optional).
Before connecting the AC adapter, switch
the USB Connection setting to [AC] (= P.77).

[ Plug the AC adapter into AC
outlet.

Plug the recorder’s USB
connecting cable into the AC
adapter.

Make sure that the recorder is
turned off, connect the USB cable
to the connecting terminal on the
bottom of this recorder.

Charging has started when LED
indicator lightis orange and the battery
indicator on the display changes to the
charging indicator.

Power supply

« The recorder cannot be charged when the
PCis not turned on. Also, it may not be
charged when the PCis not switched on,
or whenitis in the standby, hibernate or
sleep mode.

« Do not charge the recorder with the USB
hub connected.

« Charging is completed when battery
indication becomes [{d] (charging time:
approximately 3 hours *).

* It shows the approximate time when
charging the rechargeable battery fully
from no remaining power at the room
temperature. The charging time will be
changed depending on the remaining
amount and the state of battery.

« You cannot charge when [{#]*1 or [fI]*2
is displayed. Charge the battery at the
temperature from 5°C to 35°C (41°F to 95°F).
*1 [[@): When surrounding temperature is

low.

*2 [@1]: When surrounding temperature is

high.

+ When using time becomes notably short
even after the battery are fully charged,
replace them with new ones.

« Be sure to push the USB connector all the
way in. Otherwise, the recorder may not
operate properly.

« Besure to use the attached dedicated
cable for the USB connection cable. If
any other company'’s cable is used, it
may cause problems. Also, please do not
connect this dedicated cable to any other
company’s product.



Battery indicator

The battery indicator on the display changes
as the battery loses power.

i) <y (74 5 (4]

When [{4]] appears on the display,
replace the battery as soon as possible.
When the battery is too weak, [{1]] and
[Battery Low] appears on the display, the
recorder shuts down.

While charging, the battery indicator
constantly changes and does not show the
actual amount of power remaining.

Cautions concerning the rechargeable batteries

Read the following descriptions carefully
when you use the lithium ion battery (LI-
50B).

Discharging:

The rechargeable batteries self-discharge
while this is not in use. Be sure to charge
them regularly before use.

Operating temperature:

The rechargeable batteries are chemical
products. The rechargeable batteries
efficiency may fluctuate even when
operating within the recommended
temperature range. This is an inherent
nature of such products.

Recommended temperature range:
When operating appliance:
0°C-42°C/ 32°F - 107.6°F
Charging:
5°C-35°C/41°F - 95°F
Storage for a long period:
-20°C - 30°C/ -4°F - 86°F

Power supply

Using the rechargeable battery outside

the above temperature range may result in
declining efficiency and shorter battery life.
In order to prevent battery leakage or rust,
remove the rechargeable battery from the
products when you will not be using them
for along time, and store them separately.

This recorder is designed to fully charge
batteries regardless of their energy level.
However, for best results when charging
newly purchased rechargeable batteries
or batteries that have not been used

for along time (more than one month),
itis recommended to fully charge the
batteries then discharge repeatedly for 2
to 3 times.

When disposing rechargeable batteries,
always observe the local laws and
regulations. Contact your local recycling
center for proper disposal methods.

If lithium ion batteries are not fully
discharged, protect against short-
circuiting (e.g. by taping the contacts)
before disposing.

For customers in Germany:

Olympus has a contract with the GRS (Joint
Battery Disposal Association) in Germany to
ensure environmentally friendly disposal.
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Turning on/off the power

When the recorder is not being used, turn
the power off to reduce battery consumption
to a minimum. Even if the power is turned
off, existing data, mode settings, and clock
settings will be maintained.

Turning on the power

While the recorder is turned off,
slide the POWER/HOLD switch in the
direction indicated by the arrow for
2 seconds or longer.

4-POWER| - HOLD

\

+ The LED light will light up then power will
be turned on and the display will turn on
showing the OLYMPUS logo.

Power supply

Turning off the power

Slide the POWER/HOLD switch in the

direction indicated by the arrow for

1 seconds or longer.

« The display shuts off, and the power will
be turned off.

“4-POWER| " HOLD

Auto Power off mode

If the recorder is on and stops for 10 minutes
orlonger (default setting), the recorder enters
Auto Power off mode and turns off the power.
You can set the time to enter power save
mode from among [Sminutes], [10minutes],
[30minutes], [1hour], [2hour], [3hour] and
[Off] (v= P.77).

To exit Auto Power off mode , turn on the
power again.



HOLD

If you bring the POWER/HOLD switch to the [T
HOLD position, the current conditions willbe If you press any button in Hold mode, the

preserved, and all buttons and switches will LED indicator light flashes blue but no
be disabled. This feature is useful when the operlaticlm is peI?formed. uebu

recorder has to be carried in a bag or pocket. : K .
. N « IfHOLD is applied during playback
Also, you can stop to prevent accident during (recording),popperation isgdri)sagled with

recording. the playback (recording) state unchanged
(When playback has ended and the
recording has ended due to the remaining
memory being used up, it will stop).
Slide the POWER/HOLD switch to the
HOLD position.

t

Qa10H

< POWER [FHOLD

« After [Hold] appears on the display, the
recorder is set to HOLD mode.

Exit HOLD mode

Slide the POWER/HOLD switch to the
® position.

HOLD

[
W
2
o
o
|
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Setting time and date [Time & Date]

If you set the time and date beforehand,
the information when the file is recorded is
automatically stored for each file. Setting the
time and date beforehand enables easier file
management.

When you use this recorder for the
first time after purchasing, or when
you switch it on after removing the
batteries for more than 15 minutes
when exchanging batteries etc, the
[Set Time & Date] will appear. When
the “hour” is flashing, conduct the
setup from Step 1.

The voice control function can be
used with this setting

(== P.107) (For DM-5).

[l Press the Bp or € button to
select the item to set.

+ Select the item from the “hour”,
“minute”, “year”, “month” and “day”

with a flashing point.

Time

M D
Sl
-;EI]II]@E.I]E
//?\\

10:21 pum

M |
A/ ]
2010.84.15

= ~
//?\\
10:21 pum

- Follow the same steps by pressing the
PP or 4 button to select the next
item, and press the + or — button to
set.

« Youcanselectbetween 12and 24 hour
display by pressing the F2 (24H) button
while setting the hour and minute.
Example: 10:20 P.M
10:20PM :

(Initial setting) 22:20

« Youcanselectthe orderofthe “month”,
“day” and “year” by pressing the F2
(M/D/Y) button while setting them.
Example: April 15,2010

2010v 4m 150
(Initial setting)

v

M 15D 2010Y

15p4m 2010v

B Press the > OK button to
complete the setting.
« The clock will start from the set date

and time. Press the > 0K button
according to the time signal.

« If you press the 0K button during the
setup operation, the recorder will save the
items that were set to that point.

« After setup, a message will sound saying
that if the guidance is not required, select
[Off], and the display goes into [Voice
Guide] (== P.85) setup. If you don't want
the guidance feature, select [Off].



Setting time and date [Time & Date]

Changing the time and date

If the current time and date is not correct,
set it using the procedure below.

, The voice control function can
v.0|cE be used with this setting
(= P.107) (For DM-5).

[ select [Time & Date] from the
menu on the [System Menu].
Fordetails on how to enter the menu

settings, please see “Menu setting
method” (©==P. 65).

Press the PP or €4« button
to select the item to set.

Select the item from the “hour”,

“minute”, “year”, “month” and “day”

with a flashing point.

M D
QW
=201 I]@E.I]E

77
10:21 pu

Press the + or - button to set.

10:21 pum

Follow the same steps by pressing
the PP or € button to select
the next item, and press the + or —
button to set.

n After the date and time have
been set, press the » 0K button.

[23eq '3 2w} ] 33ep pue dwiy) bunes i
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Inserting and ejecting a microSD card

The “microSD” indicated in the instruction
manual refers to both microSD and
microSDHC. This recorder can be used with
commercially available microSD cards as
well as the built-in memory.

Inserting a microSD card

n While the recorder is during stop
mode, open the card cover.

Close the card cover securely.

When you insert the microSD card,
the recording media changeover
display will appear.
n When you are recording to a
microSD card, press the + or —
button and select [Yes].

Face the microSD card the correct
way and insert it into the card
slot as shown in the diagram.

Insert the microSD card keeping it
straight.

Inserting the microSD card the wrong
way or at an angle could damage the
contact area or cause the microSD
card to jam.

If the microSD card is not inserted all
the way, data cannot be written to the
microSD card.

I_I

Press the > OK button to complete
the setting.

« Itis possible to switch the recording media
over to the built-in memory (s P.77).

« In some cases microSD card which have
been formatted (initialized) by another
device, such as a computer, cannot be
recognized. Be sure to format them with
this recorder before using (= P.94).



Inserting and ejecting a microSD card

Ejecting a microSD card

n While the recorder is during stop
mode, open the card cover.

Push the microSD card inward to
unlock it, and let it eject partially.

«  The microSD card is visibly out of the
slot and can be removed safely.

+ When [Memory Select] is set to
[microSD Card], [Built-in Memory
Selected] will appear.

H Close the card cover securely.

Releasing your finger quickly after pushing
the microSD card inward may cause it to
eject forcefully out of the slot.

Before inserting the microSD card, turn off
the write protection function. Check the
Olympus website regarding microSD cards
which are confirmed operation with this
recorder.

This recorder may not recognize correctly
on some microSD cards which are not
compatible with this recorder.

In the case when the microSD card cannot
be recognized, remove the microSD card
then put it in again to see if this recorder
recognizes the microSD card.

The processing performance reduces in a
microSD card when you repeat writing and
delete. In this case, format the microSD card
(= P.94).
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Notes on the folders

The built-in memory or the microSD card can be used for the recording media. Regardless
of the recording media, voice file, music files, and contents files are separated and saved
respectively into the folders organized in a branching tree-style.

About the folders for voice recordings

[Folder A] - [Folder E] within the [Recorder] folder are the folders for voice recordings.
When recording with this recorder, select any one of the five folders and then record.

« Files or folders located under the folder [Recorder] will not be indicated on the recorder.

.

Folder File

Recorder

£

Folders for voice recordings

VOC_100201-0001.wav

—

Folder A
Folder list File list

display —( VOC_100201-0002.mp3 ] display
] s

ﬁ VOC_100201-0003.wav
ﬁ VOC_100201-0004.wma ]

N
L Each folder can store up to 999 files.

Folder B

Folder C

Folder D

S mmEm————————-

ERFEE ™ TERU ™

File names will be automatically created for files recorded by this recorder.
Example: February 1, 2010 is displayed
VOC_ 100201' 0001 -Wma 351'103201"‘ y play
e number:
@ Fil b
@ A serial number automatically

assigned by a Digital Voice Recorder.
@) User ID: (@) Extension:
These are the file name extensions for
the recording format when recording
with this device.
« Linear PCM format: .wav

The user ID name that has been set on
the Digital Voice Recorder. The user
ID can be changed in the Olympus

Sonority.

(2 Recording date: : mﬁ;‘;rmat}. -mp3
The recording date is displayed using : ormat: wma
six digits.

p




Notes on the folders

About the folder for music playback

When transferring music files to the device using Windows Media Player, a folder is
automatically created within the [Music] folder which has a layered structure as shown in the
diagram below.

First layer Second layer Third layer

File searches are
performed to the
4th layer.

_—) |
— ) ()

_[ ] File

« It can be stored a total of 999 files and folders in the each folders of [Music] folder.
« Up to 8000 songs can be transferred to the [Music] folder.
Up to 1000 playlists can be transferred to the [Music] folder.

File search Artist list Album list File list display
display display display

T
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Notes on the folders

About the folder for Podcast contents

A [Podcast] folder to store podcasts is prepared in advance. Programs (files) transmitted
from the “Olympus Sonority” can be played. With the recorder stopped, open the [Podcast]
folder at the [Home] menu to display a list of files and folders stored in the folder.

For “Podcast” please see 1= P.127.

First layer Second layer
g
o
2 Fil h
Ile searches are
e Podcast Program _D performed to the
= 4th layer.
3
-
- )
-
o
: —_)
)
—_ )] =)
] ]
] ]
] ]
<~ <~
« It can be stored a total of 999 files and folders in the each folders of [Podcast] folder.
« Upto 8000 files can be transferred to the [Podcast] folder.
Program list File list File display
display
EN

34



Notes on the folders

About the folder for electronic book contents and text files

A folder to store electronic book files such as DAISY content and audiobooks is prepared in
advance. Electronic book files that have been transferred to the recorder can be listened to.
Furthermore, afolder to manage text dataimported to the recorder is also prepared in advance.
For “DAISY” please see v P.132, for “Audio Book" please see 1= P.157, for “Text Speech” please
see = P.158.

First layer Second layer

Contents

Folder

Contents

$19P|0J 3Y3 U0 SAJON

Contents

File

Contents

-
§eee-

« It can be stored a total of 999 files and folders in the each folders of [Daisy] folder.
« Upto 1000 contents can be transferred to the [Daisy] folder.

Folder list Contents list File list display File display
display display
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Notes on the folders

First layer Second layer

Audio Book Contents I

Contents Folder File

« It can be stored a total of 999
files and folders in the each
folders of [Audio Book] folder.

+ Upto 1000 contents can be
transferred to the [Audio
Book] folder.

Folder list Contents list
display display

Text Speech - D

Folder File

« It can be stored a total of 999
files and folders in the each
Folder list File list display File display folders of [Text Speech] folder.
display « Up to 1000 files can be
transferred to the [Text Speech]
folder.

Al




Notes on the folders

About the folder for Audible contents

Audible files can be redirected from the Audible website to the recorder using the
AudibleManager (= P.159) or Windows Media Player.

When redirecting Audible files to this recorder using the AudibleManager, an [Audible]
folder for playing Audible files will automatically be created in the [Audiobooks] folder, and
the files stored there.

When redirecting Audible files to this recorder using the Windows Media Player, an [Artist]
folder for playing will be created in the [Audiobooks] folder, just like for music files, and the
files will be stored there.

Audible

First layer Second layer Third layer

L ]

| ] | ]

L ] L ] L ]

L] L} n
R R

It can be stored a total of 999 files and folders in the each folders of [Audible] folder.

Folder list Artist list Album list File list
display display display display

e
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Notes on the folders

About the folder for picture

A folder to store images imported from a connected digital camera is prepared in advance.
The [IMAGE] folder is managed by the dates images were taken.
For “Viewing images” please see = P.103.

First layer Second layer

Folder

CJ

File

« Each folder can store a total of 999 items, including files and folders.
« When the recorder displays image files, only thumbnails are displayed.

Folder display Date list display File list display File display

2010.01.06 SN
2010.01
2010.01.04 F

100904 1008,
09

X T8 A o DX T 00 A,
i

[




Basic operations

.
Recording

Various recording settings can be made to
match the recording environment (s P.67
to P.70).

[Rec Menu] Setting Items:

[Mic Sense] Sets the sensitivity of the
(= P.67) built-in stereo microphone.
[Rec Mode] Sets the recording rate for
(v P.67) each recording format.
[Rec Level] .

(= P.67) Sets the recording level.
[Zoom Mic] Sets the directionally of the
(= P.68) built-in stereo microphone.

This function can reduce

[Low Cut Filter] noise from air conditioners,

(+= P.69) projectors and other similar
noises.
Sets the threshold level for
Eécr‘!glg) the Variable Control Voice
. Actuator (VCVA).
Saves recording settings in
{ll;e;ss%e)ne] advance for specific record-
- ing situations.
{I;np\esr‘ll)lec] Sets timer recording.

[Folder Name] You can change folder names

(== P.70) registered in the template.

+ Eachaudiorecordingis saved automatically
with a generated file name (== P.32).

+ Audio recordings can be tagged with a
keyword to make file management easier
(v P.75).

Recording to a recording folder

Before starting recording, select a voice
recording folder between [Folder A] to
[Folder E] in the [Recorder] folder. These
five folders can be selectively used to
distinguish the kind of recording; for
example, [Folder A] might be used to
store private information, while [Folder B]
might be dedicated to holding business
information.

I select the recording folder.

Press the REC button to start
recording.

- The LED indicator light glows orange
and [.a.] will appear on the display.

« Turn the microphone in the direction
of the source to be recorded.

TNDEX MENU

Buipioray
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Press the STOP button to stop
recording.

@ Filelength

Specifying a keyword before
recording

A keyword that matches the contents to be
recorded can be specified before recording
starts. This functionis very useful for classifying
recordings by keywords.

n In the Folder list display, press
F1(SEARCH) to show the Keyword
search display (== P.53).

Press the + or — button to specify
the desired keyword, and then
press the »OK or & button.

Recording

B Press the REC button to start
recording.

Press the STOP button to stop
recording.

F1 F2

(|

I
-
S| voL REC

Recorded files are automatically
tagged with the specified keyword
and managed using the keyword list.
Recorded files are saved in [Folder A].
If [Folder A] is full, files are saved in
[Folder B].



When a microSD card is inserted in the
recorder, be sure to confirm the recording
media as either [Built-in] or [microSD] so
that there is no mistake (v P.77).

If the REC button is pressed when a
function other than the record function is
specified, [Cannot record in this folder]

is displayed. Select a folder from [Folder
A] through [Folder E] and start recording
again.

To ensure recording from the beginning,
start speaking afteryou see the LED indicator
light on.

When remaining recording time is less
than 60 seconds, the LED indicator light
starts flashing. When the recording time

is decreasing to 30 or 10 seconds, the light
flashes faster.

When [Folder Full] appears, the recorder
will not be able to record anymore. Delete
any unnecessary files before recording any
further (= P.60).

Recorder will not be able to record
anymore when [Memory Full] appears.
Delete any unnecessary files before
recording any further (== P.60).

We recommend formatting the record
media in the recorder before recording

(v= P.94).

Recording

Whiletherecorderis duringrecording
mode, press the RECbutton.

32BiSbs

« The recorder will time out after 120
minutes when left in “Rec Pause”.

Resume Recording:
Press the REC button again.

«+ Recording will resume at the point of
interruption.

Buipioray H

To quickly check on the recorded contents

While the recorder is during
recording mode, press the » 0K
button.

« Stop recording and the file that was just
recorded will be played back.

EN
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Listening while audio is recorded

If you start recording after inserting the
earphone into the EAR jack on the recorder,
you can hear the sound being recorded. The
recording monitor volume can be adjusted by
pressing the + or — button.

Connect the earphone to the EAR jack
on the recorder.

« After recording has started, you can hear

the sound being recorded through the
earphone.

To EAR jack

Recording level cannot be controlled using
the volume button.

When using the earphones, do not set the
volume too high. Listening at very high
volume may lead to hearing loss.

Do not place earphones near a microphone
as this may cause feedback.

When the external speaker is connected
while recording, there is a risk that audio
feedback will occur.

Recording



Recommended settings by recording condition

The recorder is initially set to the [ST XQ] mode so that you can make high quality stereo

recordings immediately after purchasing it. The various functions relating to recording can
be configured in detail to suit the recording conditions.
The following table shows the standard recording settings with the recording environment

asan example.

Recording

Recommended Settings

ing, and railway
sounds.

[PCM]: [44.1kHz]

volume being
recorded.

Recording
condition [Rec Mode] [MicSense] | [Low CutFilter] | [Zoom Mic]
(+= P.67) (v= P.67) (== P.69) (r= P.68)
R ing f
Recordngfor | s aazus
el el (ki [WMA]:[ST XQ] [High] [Wide]
o= [MP3]: [320kbps]

groups.
Meetings and [WMAL:[ST XQ]
business negotia- [WMAJ:[ST HQ] . [On] .
tionswithasmall | [MP3}: (256kbps] (Middle] Wide)
number of people. [MP3]: [192kbps]
Dictation with a
lot of background [HQ] [Low] [Off]
noise.
it plkyiing, pﬁsztehseerr?siictwi—ty
wild birds sing- [PCM]: [48kHz] according to the (Off] (Off]

Dictationina
quiet environ-
ment.

It can be used in any type of setting.
Select a setting for recording.

Buipioday H
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Recording from external microphone
or other devices

The external microphone and other devices

can be connected and the sound can be

recorded. Connect as follows by the device

to be used.

+ Do not plug and unplug devices into the
recorder’s jack while it is recording.

Recording with external
microphone:

Connect an external microphone to
the MIC jack of the recorder.

Recording

Compact Gun Microphone
(unidirectional): ME31
The directional microphones are useful
for recordings such as outdoor recording
of wild birds singing. The metal-cut
body provides a sturdiness to the high
rigidity.

To MIC jack

%
=

Applicable external microphones

2 channel microphone
(omni-directional): ME30W
These are highly sensitive omni-
directional microphones supported by
plug-in power which are well-suited to
recording musical performances.

Highly sensitive noise-cancellation
monaural microphone (unidirectional):
ME52W
This microphone is used to record
sound at a distance while minimizing
surrounding noise.

Tie clip microphone (omni-directional):
ME15
Small concealing microphone with a
tie-clip.

Telephone pickup: TP7
Earphone type microphone can be
plugged into your ear while phoning.
The voice or conversation over the
phone can be clearly recorded.

+ The built-in microphone will become
inoperable when an external microphone
is plugged into the recorder’s MIC jack.
Microphones supported by plug-in power
can also be used.

When an external monaural microphone
is used while [Rec Mode] is set to a stereo
recording mode, it enables recording only
with the L channel microphone (= P.67).



Recording the sound of other
devices with this recorder:

The sound can be recorded when
connecting to the audio output terminal

(earphone jack) of the other device, and the
MIC jack of the recorder with the connecting

cord KA333 (optional) for dubbing.

Recording

Recording the sound of this
recorder with other devices:

The sound of this recorder can be recorded
to other devices when connected to the
audio input terminal (microphone jack)

of other devices and the EAR jack of this
recorder, with the connecting cord KA333
(optional) for dubbing.

To audio output terminal
of other devices

To MIC
jack

To audio input
terminal of
other devices

Buipioday H

To EAR
jack

+ The detailed input levels cannot be

adjusted with this recorder (5= P.67). When
external devices are connected, perform a
test recording and then adjust the output

level for the external devices.

« When you adjust the various sound
quality settings related to playback on
the recorder, the audio output signal sent
out from the EAR jack will change as well
(= P.71).
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Playback

The recorder can playback WAV, MP3

and WMA format files. To playback a file
recorded with other machines, you need to
transfer (copy) it from a computer.

Settings relating to playback

A playback mode can be selected to match
your objectives and preferences (= P.71
to P.73).

[Play Menu] Setting Items:

If recorded audio is difficult
to understand because of

[Noise Cancell noisy surroundings, adjust

(= L) the Noise Cancel setting
level.
Level adjustments of
[EUPHONY] the [EUPHONY] setting can
(= P.71) be set to four stages accord-

ing to preference.

The recorder has a Voice
Filter Function to cut low

[Voice Filter] and high frequency tones

(= P.71) during normal, fast, or slow
playback, and enable clear
audio playback.

[Repeat] The repeat playback method

(= P.72) can be specified as desired.

[Random] Files are searched for, selected

(= P.72) and played at random.

[Play Speed]
(= P.73)

Playback speed can be
adjusted as necessary.

n To start playback, select the file
to be played, and then press the
» OK button (*= P.53 to P.59).

Press the + or — button to adjust
to a comfortable listening
volume.

& 72
— T

sTop REC
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TNDES WENU

« The volume can be adjusted within a
range from [00] to [30].

H Press the STOP button at any
point you want to stop the
playback.

[Skip Space]
(= P.73)

The skip interval length can
be set.

Playback settings of your
choice can be saved to suit
different sound qualities and
playback methods.

[Play Scene]
(= P.84)

« This will stop the file being played
back midway.



While the recorder is during stop
mode, press and hold the PP
button.

« If you release the button, it will stop.
Press the »OK button to start playback
from where it was stopped.

While the recorder is during

playback mode, press and hold the

P button.

+ When you release the button the recorder
will resume normal playback.

« Ifthereis anindex mark in the middle
of thefile, the recorder will stop at that
location (= P. 51).

» Therecorder stops when it reaches the
end of the file. Continue pressing the P&
button to proceed with the cue from the
beginning of the next file.

While the recorder is during stop
mode, press and hold the | ¢4«
button.

« If you release the button, it will stop.
Press the »OK button to start playback
from where it was stopped.

While the recorder is during

playback mode, press and hold the

|4 button.

+ When you release the button the recorder
will resume normal playback

« Ifthereis an index mark in the middle
of thefile, the recorder will stop at that
location (== P. 57).

« The recorder stops when it reaches the
beginning of the file. Continue pressing
the <4< button to proceed with the
review from the end of the previous file.

Playback

Locating the beginning of the file

While the recorder is during stop
mode or playback mode, press the
P button.

« The recorder skips to the beginning of the
next file.

While the recorder is during

playback mode, press the €4«

button.

« The recorder skips to the beginning of the
current file.

While the recorder is during stop

mode, press the €4« button.

« The recorder skips to the beginning of the
previous file. If the recorder stops midway
of the file, return to the beginning of the
file.

While the recorder is during

playback mode, press the €4«

button twice.

« The recorder skips to the beginning of the
previous file.

« When you skip to the beginning of the file
during playback, the recorder will stop at
the position of the index mark. The index
mark will be skipped when you perform
the operation in stop mode (e P. 51).

« When [Skip Space] set to other than
[File Skip], the recorder will skip forward/
reverse the specified time, then will start
playback (s= P. 73).

yegheld
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Playback

Playback through earphone About music file

An earphone can be connected to the EAR

jack of the recorder for listening.

+ When the earphone is used, the recorder
speaker will be switched-off.

In cases where the recorder is unable

to playback music files that have been
transferred to it, check to make sure that the
sampling rate and bit rate are in the range
where playback is possible. Combinations of
sampling rates and bit rates for music files
which the recorder can playback are given
below.

To EAR
jack File Sampling Number of bit
format | frequency and Bitrate
\fNAV 44.1 kHz, 48 kHz 16 bit
ormat
MPEG1 Layer3:
32 kHz, 44.1 kHz,
MP3 48 kHz From 8 kbps up to
format | MPEG2 Layer3: 320 kbps
16 kHz, 22.05 kHz,
24 kHz
8 kHz, 11 kHz,
To avoid irritation to the ear, insert the PMA | oKtz 22kHz | From S kbpsup to
earphone after turning down the volume e 431?; k:i 441 kHz, | 320 kbps

level.

When you listen with the earphone during
playback, do not raise the volume too
much. It may cause hearing impairment
and decrease in hearing ability.

Playback through Hi-fi components or Car Audio

The KA333 (optional) connects from the

EAR jack of a voice recorder to the audio
input of another recording device. You

will also be able to use in your car via the
AUX-IN connection. Additional plug adapter
to convert 3.5 to 2.5 and vice versa are
included.

« Variable bitrate MP3 files (in which
conversion bitrates can vary) may not play
properly.

« This recorder does not support the Digital
Rights Management system (DRM) of the
Microsoft Corporation.



Bookmark mode

The recorder has the bookmark mode

in the contents file of the [Podcast],
[Audiobooks](Daisy, Audio Book, Text
Speech, Audible) file which is transferred

to the recorder. When the recorder is in
bookmark mode, it automatically memorizes
the last stop position as a Playback Position.
Even the recorder is stopped while a file is
being played back, the last stop position

is recalled from the file, and the file can be
played back from that position next time.

n Selecting the content file in the
[Podcast], [Audiobooks](Daisy,
Audio Book, Text Speech,
Audible) folder.

Press the > 0K button to start
playback.

When you play the file which you have
previously played back, the playback
starts from the last stop position.

Press the STOP button at any
point you want to stop the
playback.

Playback

Stop a file playback at any point.
The stop position is memorized as a
Playback Position in the file. In this
status, even if you select an empty
file, move to the other folder, or turn
the recorder off, the playback starts
from the last memorized position
when you play the same file.

Playing back the contents file
which has been played back
halfway.

Press the »OK button to start playing
back from where it was stopped.

While the recorder is during stop
mode, press and hold the PP button.

= When you release the button, the
recorder stops.
The Playback position is updated. If the
» 0K button is pressed, playback starts
from this position.
While the recorder is during playback
mode, press and hold the PP button.

= When you release the button the
recorder will resume normal playback.

« Ifanindex mark (== P.51) or Playback
Position is marked in the middle of the file,
the playback stops once at that position.

« The recorder stops when it reaches the
end of the file. Continue pressing the B9
button to proceed with the cue from the
beginning of the next file.

yegheld H
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While the recorder is during stop
mode, press and hold the ¢« button.

= When you release the button, the
recorder stops.
The Playback position is updated. If the
» 0K buttonis pressed, playback starts
from this position.
While the recorder is during playback
mode, press and hold the €4« button.

= When you release the button the
recorder will resume normal playback.

« If an index mark (s P.51) or Playback
Position is marked in the middle of the file,
the playback stops once at that position.

» The recorder stops when it reaches the
beginning of the file. Continue pressing
the @ button to proceed with the review
from the end of the previous file.

« If the @ button is kept pressed while the
recorder is stopped at the start of the top
file, the recorder will fast rewind starting
from the end of the last file.

To skip afile

While the recorder is during stop
mode, press the P button.
= |t skips to the Playback Position of the
next file.
While the recorder is during stop
mode, at the beginning of the file,
press the |4 button.
= |t skips to the Playback Position of the
previous file.
While the recorder is during stop
mode, in the middle of the file, press
the |4« button.

= |t skips to the head of thefile.

Playback

Locating the Beginning of the File

While the recorder is during
playback, slow playback, or fast
playback, press the PP button.
= The next file is cued and playback
starts at the previously set speed.
While the recorder is during
playback, slow playback, or fast
playback, press the <4« button.
= The file being played is cued and
playback starts at the previously set
speed.
While the recorder is during
playback, slow playback or fast
playback, press the 4« button
twice.
= The previous file is cued and playback
starts at the previously set speed.

« If an index mark (== P.51) is marked in the
middle of the file, it reproduces from the
position.

« If the skip space is set at other than file skip
(== P.73), the recorder will F. Skip (forward
skip) or R. Skip (reverse skip) for a set time
before playback.

« If the file is deleted with this recorder, the
Playback Position information is deleted
simultaneously.



Setting an index mark

If index marks are placed, you can quickly
find a location you want to listen to in fast
forward and fast rewind and when cuing
afile.

Playback

I Locate the index mark you want
to clear.

Press the PP or €4 button to
select the index mark to erase.

This operation can be performed
when the [INDEX] function has
been assigned to a Fn button (F1
or F2) (= P.76).

n Press the Fn (INDEX) button during
file recording, recording pause,
playing, or playback pause.

05T TNDEX WENU

H While the index number is
displayed (approximately 2
seconds), press the Fn (ERASE)
button.

A number and recording position
appears on the display and an index
mark will be placed.

Even after an index mark is placed,
recording or playback will continue
so you can place index marks in other
locations in a similar manner.

Clearing an index mark

This operation can be performed
when the [Erase] function hasbeen
assigned to a Fn button (F1 or F2)
(= P.76).

The index mark is erased.
Index numbers after the erased index
number will automatically move up.

« Upto 16 index marks can be setin a file. If
you try to place more than 16 index marks,
the [Index Full] message will appear for
index marks.

« Index marks cannot be set or erased in a
locked file (= P.75).

yegheld H
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How to begin segment repeat
playback

This function enables repeated playback of
part of the file being played.

This operation can be performed
when the [A-B] function has been
assigned to a Fn button (F1 or F2)
(== P.76).

I To start playback, select afile that
has a segment you would like to
playback repeatedly, and then
press the »OK button (= P.53 to
P.59).

Press the Fn (A-B) button at the
point you want to start segment
repeat playback.

Fast forwarding and rewinding can
be conducted when [A[l is flashing
in the same manner as during normal
playback, and you can quickly
proceed as far as the end position

(v= P.A47).

When it reaches to the end of the file
while [A]l is flashing, the point will
become the end position, and repeat
playback will start.

RU/ZANZ\178
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Playback

Press the Fn (A-B) button again at
the position where you want to
end segment repeat playback.

« Therecorder repeatedly plays back
the segment until the segment repeat
playback is cancelled.

Cancel the segment repeat playback function

Pressing any of the following
buttons will release the segment
repeat playback.

(@ Press the STOP button
Pressing the STOP button will release
segment repeat playback and stop
playback.

(o) Press the » OK button
Pressing the »OK button will release
segment repeat playback, and it will
return to normal playback mode.

(© Press the F1 (CANCEL) button
Pressing the F1 (CANCEL) button will
release segment repeat playback and
stop playback.



File search

This recorder ma
musicfilesimporte

nages recorded files and
dfromapersonal computer

using a database. Files are automatically
sorted using items such as date and keyword,
which makes searching for files easier.

Opening the file search display from

the [Recorder] folder
File search type:
The folder system (Folder A
{E;:“;s:)] Eeauch to Folder E) is used to search
E for files.
[Day] Search Files are searched for by
(== P.54) recording date.
[Keyword] Files are searched for by a
pearch keyword
(= P.55) yword.

n From the [H

ome] menu display,

select [Recorder], and then press
the » OK or P button to open

the folder li

st display.

F1 P2 3
(] a— ] —)

Press the F1 (SEARCH) button to
open the file search display.

The search display changes every time
the F1 (SEARCH) button is pressed.

(@) =) w)

CO).=

sTOP voL REC

Lﬂ

proceed to “File search display

Select the type of file search. Next,
operations of the [Recorder] folder”.

ypaeas ajy
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File search display operations of the
[Recorder] folder

When searching using the [Browse] search

Specify a folder to search for files recorded
by this recorder.

(@ Press the + or - button to select folder,
and then press the »OK or PP button.

File search

When searching using the [Day] search

Search for a file using the recording date. The
most recent recording date is highlighted.
Highlight the desired recording date.

(D Press the + or — button to select the
recording date, and then press the > 0K
or PP button.

l\l

(2 Press the + or - button to select file, and
then press the 0K or B>¥ button.

F2 3

l\_l_

+ Press the » 0K button to start
playback of the file.

(2 Press the + or - button to select file, and
then press the 0K or BB button.

[N ] an 10:5 1 (]
2010.01.10 THY

« Press the »OK button to start
playback of the file.



When searching using the [Keyword] search

Search forfiles recorded by this recorder using
a keyword. Files recorded by this recorder
can be tagged using a keyword for file
management purposes (= P.75).

(@ Press the + or - button to select keyword,
and then press the »0K or PP button.

l\l

(2) Press the + or - button to select file, and
then press the » 0K or PP button.

(| o | )

« Press the » 0K button to start
playback of the file.

File search

yoaeas ajy
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Opening the file search display from
the [Music] folder

File search type:

[Artist] Search

Files are searched for from a

(= P.57) list of artists.

[Album] Search | Files are searched for from a
(= P.58) list of aloum names.
AN Files are searched for from a
Search list of all songs

(== P.57) .

[Browse] Search
(== P.59)

A list of all songs and albums
in the [Music] folder is dis-
played.

[Heard Re-
cently] Search
(= P.58)

Files played on this recorder
are displayed reverse chrono-
logical order.

[Play Count]

Files are displayed in order of

Search the number of times they have
(== P.58) been played on this recorder.
[ayllzts] Displays playlists transferred

Search h q

(= P.59) to the recorder.

File search

n From the [Home] menu display,
select [Music] folder, and then
press the » 0K or P> button to
open the search display.

[

SEHE 9

Press the + or — button to select
thefilesearch type, and then press
the > 0K or P button.

« Ifyoumake a mistake during the search,
use thel<« button to return to the

previous display.

Gl Pz 3
(—) | — —

n Select the type of file search. Next,
proceed to “File search display
operations of the [Music] folder”.




File search

File search disp|ay operations of the ®Pressthe + or - button to select song, and
[Music] folder then press the 0K or BB button.

" " . ()| )| )
When searching using the [Artist] search @ :

Search for a specific artist.

(@ Press the + or - button to select artist, and
then press the » 0K or B> button.

7 3 73 « Press the »OK button to start =]
S— —  — playback of the file. e
o
-
a
=
Selecting from a list of [All Music]
Files are searched for from a list of [All
Music].
(@ Press the + or - button to select album
or song, and then press the 0K or B> (@ Press the + or - button to select song, and
button. then press the » 0K or B> button.
i m 6
(—)) — ) —)
. - Press the »OK button to start
- Ifasongis sglected, playback starts. playback of the file.
« Ifanalbumis selected, its songs are
displayed as a list.
EN
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When searching using the [Album] search

Search by specific album.

(@ Press the + or - button to select album,
and then press the 0K or PP button.

1 F2 3
(— ] — ] —)

(2 Press the + or - button to select song, and
then press the 0K or B> button.

&l 72 &
(—] G— | —)
» Feelings for you

+ Press the » 0K button to start
playback of the file.

File search

When searching using the [Heard Recently]
search

A list of recently played files is displayed in
reverse chronological order.

(@ Press the + or - button to select song, and
then press the »OK or B> button.

« Press the »OK button to start
playback of the file.

When searching using the [Play Count] search

A list of frequently played files is displayed in
reverse chronological order.

(@ Press the + or - button to select song, and
then press the » 0K or PP button.

« Press the »OK button to start
playback of the file.



When searching using the [Browse] search

Browse directly from a list of all files and
folders in the [Music] folder.

(D Press the + or - button to select a song to
be played or to select an artist, and then
press the »OK or P button.

\l\l

« Ifanartistis selected, songs in the
folder are displayed as a list. Press the
+ or - button to select a song, and
then press the 0K or BB button.

+ Press the » 0K button to start
playback of the file.

When searching using the [Playlists] search

Select a playlist.
For details on importing playlists, please see
=P.146.

(@ Press the + or - button to select [Playlists],
and then press the »0K or P button.

F3

(| | —

Playlists

File search

(2 Press the + or - button to select a
playlists, and then press the 0K or B>p
button.

P Playlists |

=
o
(3 Press the + or - button to select song, and §
then press the » 0K or B>»1 button. =
=
First
« Press the »OK button to start
playback of the file.
EN
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Erasing

A selected file can be erased from a folder. It
is also possible to erase a selected folder or

all files in a folder.

Erasing from the file display
n In the File list display, press the

F3 (MENU) button.

Files cannot be erased during playback.

F2

(— e (=)

o=

sTOP voL REC

Press the + or — button to select
[0 Erase], and then press the 0K
or PP button.

F1 F2 F3

(C— | E— ] —)

Press the + button to select
[Start], and then press the > 0K
button.

The display changes to [Erase!] and
erasing will start. [Erase Done] is
displayed when the file is erased.

Press the + button to select [File
Erase], and then press the » 0K or

| button.




Erasing

Erasing from the file list display Press the + button to select
[Start], and then press the » 0K
n Select the file to erased from the button.
file list display.

The display changes to [Erase!] and
erasing will start. [Erase Done] is
— displayed when thefile is erased.

While the recorder is during
stop mode, press the F2 (ERASE)
button.

Press the + or — button to select
[File Erase], and then press the
» OK or PP button.

& @ &
 c— — ) —)
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Erasing All Files in a Folder

n Select the folder to be erased
from the folder list display.

EN
62

While the recorder is during

Erasing

Press the + button to select
[Start], and then press the » 0K
button.

> Folder A
F

The display changes to [Erase!] and
erasing will start. [Erase Done] is
displayed when the file is erased.

stop mode, press the F2 (ERASE)

button.

Press the + or — button to select

[Erase in Folder], and then press
the » 0K or P button.

@] 3 3
(G—) — ) —)




Erasing

Press the + button to select
[Start], and then press the » 0K

n Select the folder to be erased button.
from the folder list display.

Erasing a folder

|

The display changes to [Erase!] and
erasing will start. [Erase Done] is
displayed when the file is erased.

Buisesy

In the folder list display, press
the F3 (ERASE) button.

F1 F2

) — | —

Press the + or — button to select
[0 Erase], and then press the 0K
or P button.

@] 3 3
(G—) — ) —)
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Partially erase a file

Only a PCM file recorded in the recorder can
be partially erased.

n This operation can be performed

when the [Erase] function has
been assigned to a Fn button (F1
or F2) (v= P.76).

n n Play the file you want to partial

Buisesy
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erase.

« Forward afile to the position that
shall be erased. If the file is long,
use the PP button to move to the
position you want to delete.

In the starting position of the

partial erase, press the Fn (ERASE)
button.

In the position you want to end
partial erase, press the Fn (ERASE)
button again.

« [Start point] and [End point] on the
display flash alternatively. When the
lights are flashing, playback continues
and you can rewind or fast-forward as
usual and fast-forward to the end of
erase. If thefile reaches the end during
the flashing of the lights, that will be
the position where erase ends.

Erasing

Press the Fn (ERASE) button

again.

- Thedisplay will switch to [Partial
erasing!] and start the partial
erase. The deletion is completed
when [Partial erase completed.] is
displayed.

« Playback will stop at the end location
of the partial erase.

- Partial erase is not applicable to files
recorded in the WMA or MP3 formats.
The file created date will not change even
if the file is partially erased.
An erased file cannot be restored. When a
microSD Card is inserted in the recorder,
be sure to confirm the recording media as
either [Built-in] or [microSD] so that there
is no mistake.
The locked files and files set as read-only
cannot be erased (== P.75).
If an action is not selected within 8
seconds, the recorder will return to stop
status.
Never perform operations such as the
following while processing, as they may
damage the data. In addition, carefully
check the remaining battery level in order
to ensure that the battery will not run out
while processing.
@ Unplugging the AC adapter while
processing.
(2 Removing the battery while processing.
(3 Remove the microSD card during
processing when [microSD] is
being used as the recording media.
Performing any of these operations
may damage the data.
[Recorder] folder (A-E) as well as [Music],
[Podcast], [Audiobooks](Daisy, Audio
Book, Text Speech, Audible) folders cannot
be deleted.



Menu setting

Menu setting method

You can set the various functions of this
recorder. You can set each menu item as
follows.

Making settings from [Preferences] on
the [Home] menu display

From menu on the [Home] menu display,
following settings can be made: [Rec Menu],
[Play Menu], [LCD/Sound Menu], and
[System Menu]. You can perform various
settings on this recorder before recording
or playback.

n From the [Home] menu display,
select [Preferences], and then
press the » 0K or PP button to
open the menu item display.

(| | )

Press the + or — button to select
amenu item, and then press the
» 0K or P> button.

@ @ &
 e— — ) —)

Press the + or — button to select
the setting item, and then press
the » 0K or P> button.

Moves to the setting of the selected
item.

If you make a mistake while performing
a setting, press thel<d< or F1 (BACK)
button to return to the previous
display.

poyjaw buyyas nuay H

n Press the + or — button to change
thesetting, and then pressthe» 0K
button to complete the setting.

Gl 7z 3
(— ] — ] —

Middle

You will be informed that the settings
have been established via the display.

Press the F3 (HOME) button to
close the menu display.
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Performing menu settings during
recording, playback, and stop modes

Menu settings can be performed while this
recorder is being operated. In addition to [Rec
Menu] and [Play Menu] settings, [File Menu]
settings for file management can also be
performed from the menu during operation.

n While the recorder is recording,
playingback, paused,andstopped,
press the F3 (MENU) button.

RecMenu

i 5
(—) - o] =) ]

Press the + or — button to select
amenu item, and then press the
» OK or P button.

G vz 3
(C— | E— ] —)

Press the + or — button to select
the setting item, and then press
the > 0K or PP button.

Menu setting method

Moves to the setting of the selected
item.

If you make a mistake while
performing a setting, press thel<<
or F1 (BACK) button to return to the
previous display.

Press the + or — button to change
the setting, and then press » 0K
button to complete the setting.

Press the F3 (CLOSE) button to
close the menu display.

When the display is in the menu
display during recording or playback,
pressing the F3 (CLOSE) button will
allow you to return to the playback
display without interrupting
recording or playback.



¢T Rec Menu

Microphone sensitivity is adjustable to meet
recording needs.

n Select [Mic Sense] from the menu
on the [RecMenu].

Select [High], [Middle] or [Low].
[High]:
Highest recording sensitivity suitable
for conferences with large crowds
and recording audio at a distance or
low volume.
[Middle]:
Suitable for recording meetings and
seminars with a small number of
people.
[Low]:
Lowest recording sensitivity suitable
for dictation.
+ When you would like to clearly record
a speaker’s voice, set [Mic Sense] to
[Low] and hold recorder’s built-in stereo
microphone close to the speaker’s mouth
(5-10 cm) before recording.

The recorder can record in the linear PCM
format. High resolution recording at a high
sampling rate and high bit rate equivalent
or superior to that of a music CD is possible.
Moreover, it also supports the MP3 and
WMA formats.

n Select [Rec Mode] from the menu
on the [Rec Menu].

Select [PCM], [MP3] or [WMA].
[PCM]:

This is an uncompressed audio format
which is used for music CDs and the like.

Menu setting method

[MP3]:
MPEG is the international standard
established by a working group of
the ISO (International Organization for
Standardization).

[WMA]:
This is an audio compression
encoding method that was
developed by the Microsoft
Corporation in the US.

H Set the recording rate.

When [PCM] is selected:

[48kHz/16bit] or [44.1kHz/16bit]
When [MP3] is selected:

[320kbps] to [128kbps]
When [WMA] is selected:

[ST XQ], [ST HQ], [ST SP], [HQ], [SP], [LP]

« Torecord a meeting and lecture clearly, set
other than [LP] in Rec Rate.

« When the external monaural microphone
is used while [Rec Mode] is set to a stereo
recording mode, it enables recording only
with the L channel microphone.

Set the method for adjusting the recording level
[RecLevel]

You can set the device to automatically or
manually adjust the recording level.

n Select [Rec Level] from the menu
on the [Rec Menu].

Select [Manual] or [Auto].

[Manual]:
Recording is performed by manually
adjusting the recording level.

[Auto]:
Recording is performed by
automatically adjusting the recording
level. This is useful for when you will
be recording right away.
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Adjust the recording level:

I Press the »>» or €<t button
while the recorder is recording or
paused to adjust the recording
level.

« Therecordinglevel willbeautomatically
adjusted when the recording levelis set
to [Autol. Set the recording level to
[Manual] to use the recording level
adjustment feature.

« When the unit is set to [Manual],
the limiter function will be disabled.
Distorted sound will be recorded
during [OVER] is displayed. Adjust the
recording level so that [OVER] is not
displayed. If sound distortions do not
disappear even after the recording
level has been adjusted, change the
setting for microphone sensitivity (s
P.67) and adjust the recording level
again.

« [OVER] may be displayed even when
the indicator of the recording level
meter does not reach or is over to the
right.

« Inputting a very loud sound may
produce noise even when the recording
level is set to [Auto].

+ The level can be adjusted from [01] to
[16]. The higher the number, the higher
the level and the larger the indicator
position on the level meter.

Menu setting method

The directional microphone function utilizes
DiMAGIC's (DIMAGIC Co., Ltd.) DIMAGIC
Virtual Microphone (DVM) technology. DVM
is an audio pickup system which allows you
to record by focusing on sound from any
direction. From expansive stereo recording
to high directivity recording, DVM represents
the latest in directional control methods
that allow you to switch to a single exclusive
microphone.

n Select [Zoom Mic] from the menu
on the [Rec Menu].

Select [Zoom], [Narrow], [Wide] or
[Off].

[Zoom]:
Recording with monaural, however
you can record high directivity sound.
[Narrow]:
Recording by a directivity stereo
sound.
[Wide]:
Recording by an expansive stereo
sound.
[Off]:
Disables this function.

About the Zoom Mic function:

Directivity
(high)

- e

Directivity

(low)
Sound Sound
collection collection
(narrow) (wide)



The recorder has a Low Cut Filter function to
minimize low-frequency sounds and record
voices more clearly. This function can reduce
noise from air conditioners, projectors and
other similar noises.

n Select [Low Cut Filter] from the
menu on the [Rec Menul].

Select [On] or [Off].
[On]:
Enables the Low Cut Filter function.
[Off]:
Disables this function.

VCVA

When the microphonesenses that sounds have
reached a preset threshold volume level, the
built-in Variable Control Voice Actuator (VCVA)
starts recording automatically, and stops
when the volume drops below the threshold
level. The VCVA feature extends recording
time and conserves memory by stopping
recording during silent periods, which helps
the playback to be more efficient.

n Select [VCVA] from the menu on
the [Rec Menu].

Select [On] or [Off].
[On]:
Enables the VCVA function. Will start
recording in VCVA mode.
[Off]:
Disables this function. Will resume
recording in normal mode.

Menu setting method

Adjust the start/stop actuation
level:

« Ifthe surrounding noise is loud, the
starting sensitivity of the VCVA can be
adjusted according to the recording
situation.

n Press the RECbutton to start
recording.

« When the sound volume is lower than
the preset threshold sound level,
recording automatically stops after
1 sec approximately, and [Standby]
flashes on the display. The LED
indicator light glows orange when
recording starts and flashes when
recording pauses.

Press the P>| or 4« button to
adjust the start/stop actuation
level.

FRG) (o] O1ml 1s
|l 3.28456s
) (=) Loy
jsToP voL REC|

-l11ls@

TNDE: THENU

« The VCVA level can be set to any of 23
different values.

« The higher the value, the more
sensitive the recorder to sounds. At
the highest value, even the faintest
sound will activate recording.

(@ Level meter (varies according to the
sound volume being recorded)

() Start level (moves to the right/left
according to the set level)

« Pressthe F1 button to change the
recording level (v P.67) during VCVA
recording. The recording level can be
adjusted.

poyjaw buyyas nuay H

EN
69



poyaw Hunas nuayy !

EN
70

The start/stop actuation level also varies
depending on the selected microphone
sensitivity mode (= P.67).

If the starting level is not adjusted within
2 seconds, the display will return to the
previous.

To ensure successful recordings, prior
testing and adjustment of the start/stop
actuation level is recommended.

VCVA standby monitor setting:

When [Standby] is set to [On] with the menu
setting, the recording will not be output
from the earphone while in VCVA standby.
When you monitor your recording with the
earphone connected, you can check whether
VCVA is launched or not by checking if an
audio is output.
[On]:

Enables the Standby Monitor function.
[Off]:

Disables this function.

RecScene

Refer to “Setting the recording scene [Rec
Scene]” (= P.80).

Refer to “Timer recording [Timer Rec]”
(v P.87).

Menu setting method

Changing folder names [Folder Name]

You can change the folder names of [Folder A]
to [Folder E] for audio recording into names
preset in the template. You can also change
folder names registered in the template with
“Olympus Sonority”.

n Select [Folder Name] from the
menu on the [Rec Menu].

Press the + or — button to select
the folder name you want to
change, and then press the » 0K
or P button.

Pressthe +or—buttontoselectthe
folder name you want to change
from the template, and then press
the > 0K button.

Template list:

Sets a folder name from the preset
template.

Car Train Plane
Work Interview Business trip
Conference Lecture Class
Memo Record Telephgne
recording
Conversation Hobby Lesson
Lalnguage Music Event
esson
Folder A FolderB Folder C
Folder D Folder E
, The voice control function can
\%ICE be used with this setting
(== P.107) (For DM-5).




T Play Menu

Noise Cancel

If recorded audio is difficult to understand
because of noisy surroundings, adjust the
Noise Cancel setting level.

n Select [Noise Cancel] from the
menu on the [Play Menul].

Select [High], [Low] or [Off].

[High] [Low]:
Enables the Noise Cancel function.
Noise will be reduced in the file when
it's played back for better sound
quality.

[Off]:
Disables this function.

EUPHONY

This recorder is equipped with “EUPHONY
MOBILE", the latestin surround sound systems
which combines bandwidth correction,
expansion technology, and virtual acoustical
source processing technology. In addition
to its natural, expansive feel, the recorder
is equipped with the exceptional feature
wherein listeners are less prone to developing
a compressed or closed-in feel, or to growing
tired over extended listening.

Level adjustments of the [EUPHONY]
setting can be set to four stages according
to preference.

n Select [EUPHONY] from the menu
on the [Play Menu].

Select[Power], [Wide], [Natural] or
[Off].
[Power]:
This mode focuses more on lower
sound registers.

Menu setting method

[Widel:
This mode has an even more
expansive feel.

[Natural]:
This mode achieves natural
bandwidth correction and acoustical
field expansion.

[Off]:
Disables this function.

Voice Filter

The recorder has a Voice Filter Function to cut
low and high frequency tones during normal,
fast, or slow playback, and enable clear audio
playback.

n Select [Voice Filter] from the
menu on the [Play Menul].

Select [0n] or [Off].

[On]:

Enables the Voice Filter function.
[Off]:

Disables this function.
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The repeat playback settings can be set as
desired.

n Select [Repeat] from the menu on
the [Play Menu].

Select [1 File], [List] or [Off].
[1 File]:
Assingle file is played repeatedly.
[List]:
The displayed file list is played
repeatedly.
[Off]:
Disables this function.

Performing settings with Fn
buttons:

This operation can be performed
when the [Repeat] function has
been assigned to a Fn button (F1
or F2) (== P.76).

n Press the Fn (RPT) button.

Every time the Fn (RPT) button
is pressed, the display switches
between [, ] and [ I].

Menu setting method

The displayed file list is played repeatedly.

I select [Random] from the menu
on the [Play Menu].

Select [0n] or [Off].

[On]:
Enables the Random Playback
function.

[Off]:
Disables this function.

Performing settings with Fn
buttons:

This operation can be performed
when the [Random] function has
been assigned to a Fn button (F1
or F2) (= P.76).

n Press the Fn (RDM) button.

If the Fn (RDM) button is pressed, [O3]
is displayed and a random playback is
enabled.



Play Speed

The playback speed of the file can be changed
between [50%)] and [600%)] times speed.
Change the speed according to need such as
listening to meeting content at a fast speed
or reviewing spots that you couldn't catch in
alanguage lesson at a slow speed.

Il select [Play Speed] from the
menu on the [Play Menul].

Set the playback speed.
[50%] to [600%]

Performing settings with Fn
buttons:

This operation can be performed
when the [Play Speed] function has
been assigned to a Fn button (F1 or
F2) (== P.76).

Il Press the Fn (SPD) button.

Press the + or — button to specify
a speed setting, and then press
the » 0K button.

Restrictions on double speed playback:

Normal operation may not be available

depending onthe sampling frequency and the

bit rate of the file to be played back. In such a

case, reduce the speed of the fast playback.

« If [Play Speed] has been assigned in the
[Fn. setting] settings (v P.76), use the
assigned button to enter the [Play Speed]
setting display.

+ The [Play Speed] setting in the [Voice
Guide] settings (v= P.86) is disabled during
file playback.

Menu setting method

Skip Space

This function enables you to skip (forward) or
reverse skip (rewind) a file being played for
a set period. This function is convenient for
quickly skipping to another playback position
or repeatedly playing back short phrases.

n Select [Skip Space] from the menu
on the [Play Menu].

Select [Forward Skip] or
[Reverse Skip].

Set the skip space.

When [Forward Skip] is selected:
Playback starts after skipping forward
the specified interval.

[File Skip] [10sec. Skip] [30sec. Skip]
[1Tmin. Skip] [5min. Skip]
[10min. Skip]

When [Reverse Skip] is selected:

« Playback starts after skipping back
the specified interval.

[File Skip] [1sec. Skip] to [5sec. Skip]
[10sec. Skip] [30sec. Skip]

[1min. Skip] [Smin. Skip]

[10min. Skip]

Forward/Reverse Skip Playback:

[ Press the > 0K button to start
playback.

Press the P or €4 button.

The recorder will skip (forward) or
reverse skip (rewind) a set space and
start playing back.

If there is an index mark or a cue
closer than the skip space, the
recorder will forward skip/reverse
skip to that position.

Play Scene

Refer to “Setting the playback scene [Play
Scene]” (= P.84).
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¢T LCD/Sound Menu

Backlight

The display will remain lit for about 10 (Initial
setting) seconds when a button on the
recorder is pressed.

n Select [Backlight] from the menu
on the [LCD/Sound Menu].

Select [Lighting Time], [Dim light

Time] or [Brightness].

When [Lighting Time] is selected:
[5 seconds] [10 seconds] [30
seconds] [Tminute] [Always On]

When [Dim light Time] is selected:
[30 seconds] [Iminute] [2minute]
[Sminute] [Always On]

When [Brightness] is selected:
Adjust the setting between [01] and
[03].

Press the + or — button to change
the setting, and then press » 0K
button to confirm the setting.

The recorder beeps to alert you to button
operations or warn you of errors. System
sounds may be turned off.

n Select [Beep] from the menu on
the [LCD/Sound Menu].

Select the beep level.
Adjust the setting between [05] and [00].

Menu setting method

You can set it so the LED indicator light does
not turn on.

n Select [LED] from the menu on the
[LCD/Sound Menul].

Select [0n] or [Off].

[On]:
LED light will be set.

[Off]:
Disables this function. LED light will
be cancelled.

Language (Lang)

You can select the display language for this
recorder.

n Select [Language] from the menu
on the [LCD/Sound Menul].

Set the Language.

[English] [Frangais] [Deutsch] [Italiano]

[Espafol] [Pycckuii]:

«+ The selectable language differs depending
on the region.

Refer to “Guidance [Voice Guide]” (== P.85).

Refer to “Alarm playback function [Alarm]”
(v P.87).



¢T File Menu

Voice files recorded by this recorder can be
tagged with a keyword for file management.
File lists can be created by keyword file
searches (% P.55).

n Select the file you want to tag
with a keyword (+= P.53 to P.59).

Select [Keyword] from the menu
on the [File Menu].

Press the + or — button to select
the desired keyword, and then

press the » 0K button.
Keyword list:
Sets a keyword from the preset template.
Car Train Plane
Work Interview Business trip
Conference Lecture Class
Memo Record Telephpne
recording
Conversation Hobby Lesson
Language Music Event
lesson

Menu setting method

Locking a file keeps important data from
being accidentally erased. Locked files are
not erased when you select to erase all files
from a folder (= P.60).

I select the file you want to file
lock (== P.53 to P.59).

Select [Erase Lock] from the menu
on the [File Menu].

Select [0n] or [Off].

[On]:
Locks the file and prevents it from
being erased.

[Off]:
Unlocks the file and allows it to be
erased.

File Move/Copy

Refer to “Moving/Copying files [File Move/
Copyl” (= P.91).

Refer to “Dividing files [File Divide]”
(= P.93).
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File and folder information can be
confirmed from the menu display.

n Select the file or folder with
information you want to view in
advance (== P.53 to P.59).

Select [Property] from the menu
on the [File Menu].

Set the property.

When thefile is selected:

[Name] (File name), [Date] (Time stamp),

[Size] (File size), [Bit Rate]*1 (File format)

[Artist]*2 (Artist name) and [Album]*2

(Album name) will appear on the display.

*1 When a linear PCM format file has
been selected, [Bit Rate] area
displays the sampling frequency and
bit rate.

*2 When a file contains no tag
information, [UNKNOWN_ARTIST],
[UNKNOWN_ALBUM] will appear on
the display.

When voice file is selected, [Artist]
and [Album] will not appear on the
display.

When the folder is selected:

[Name] (File name), [Folder] (Number of

folder) and [File]*1 (Number of file) will

appear on the display.

*1 Files which cannot be recognized by
this recorder are not included in the
number of files.

« Select the files for which you would like
to confirm information in advance before
operating the menu.

Menu setting method

T System Menu

The Fn buttons (F1 and F2) of this recorder

can be assigned to suit your desired method

of use. Assigned buttons can be operated

during recording and playback.

n Select [Fn. setting] from the
menu on the [System Menu].

Select the [F1] or [F2].

« You can assign settings to suit the way you
use the recorder.

Fn button list:

Sets a Function Key from the preset
template.

Off Repeat
Random Play Speed
INDEX A-B
Erase DISPLAY
LIST

Press the + or — button to select
the item you want to assign, and
then press the » 0K button.

+ RepeatSteps 2 and 3 to continue registering
the function keys.



Memory Select

When a microSD card is inserted you
can select to record to either the built-in
memory or to the microSD card (= P.30).

n Select [Memory Select] from the
menu on the [System Menu].

Select the [Built-in] or [microSD].

Auto Power Off

If the recorder remains in stop mode for over
10 minutes (Initial setting), the power will be
turned off.

n Select [Auto Power Off] from the
menu on the [System Menu].

Select the [Sminutes], [10minutes],
[30minutes], [Thour], [2hour],
[3hour] or [Off].

[Sminutes] [10minutes] [30minutes]
[Thour] [2hour] [3hour]:
Set the length of time before the
power will be turned off.
[Off]: Disables this function.

Time & Date

Refer to “Setting time and date [Time &
Date]” (= P.28).

Menu setting method

USB Settings

You can perform two settings for connections
using the supplied USB cable. [PC] is used
when connecting to a computer to transfer
andreceivefiles.[AC]is used when connecting
to an AC adapter (A514) (Optional) for
recharging.

n Select [USB Settings] from the
menu on the [System Menu].

Select the [PC], [AC] or [EACH].

[PCI:
Setting for connecting to the
PC using the USB cable provided.
Connected as Storage.
[AC]:
Setting for connecting to the USB
connecting AC adapter (A514)
(optional) using the USB cable
provided. The recorder can be
operated on during charging.
[EACH]:
Setting to confirm the connection
method each time a USB connection
is made.

« The PC cannot recognize when the
recorder is connected to the PC when
setting for the [USB Settings] is set to
[AC].
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Reset Settings

This returns the functions back to their initial
settings (factory default).

n Select [Reset Settings] from the
menu on the [System Menu].

Press the + button to select
[Start], and then press the » 0K
button.

[Start]:

Returns the settings to their initial values.

[Cancel]:

Takes you back to the [System Menul].

Menu settings after setting reset
(initial settings):

& Rec Menu:
[Mic Sense]
[Rec Mode]

[Recording format] [WMA]

[Middle]

[Recording rate] [ST XQ]
[Rec Level] [Auto]
[Zoom Mic] [Off]

[Low Cut Filter] [Off]
[VCVA]
[On/Off] [Off]
[Standby] [Off]
[Rec Scene] [Off]
[Timer Rec] [Off]
[Folder Name] [Initial setting]
P> Play Menu:
[Noise Cancel] [Off]
[EUPHONY] [Off]
[Voice Filter] [Off]
[Repeat] [Off]
[Random] [Off]
[Play Speed] [100]
[Skip Space]

[Forward Skip] [File Skip]

[Reverse Skip] [File Skip]
[Play Scene] [Off]

Menu setting method

Sa LCD/Sound Menu:

[Backlight]

[Lighting Time] [10seconds]

[Dim lighttime]  [30seconds]

[Brightness] [Level 02]
[LED] [On]

[Beep] [Volume3]
L (Lang)] [English]
[Voice Guide]

[Menu Guide] [On]

[File Guide] [On]

[Speed] [100]

[Volume] [Volume 3]
[Alarm] [Off]

{T System Menu:
[Fn. setting]

[F11 [LIST]

[F2] [INDEX]
[Memory Select] [Built-in]
[Auto Power Off] [10minutes]
[USB Settings] [PC]

- After resetting the settings, the time
settings and file numbers will be
preserved from before the reset and will
not return to their initial settings.



Memory Info.

Therecordable capacity remaining and overall
capacity of the recording media can be seen
from the menu display.

When no microSD card is inserted only
information for the built-in memory will
seen.

The domain area which uses the
administrative files which the recorder
uses is included in the remaining capacity
for the recording media. For microSD
cards in particular, in addition to this
administrative domain the administrative
domain area for the microSD card is added
in as well. Owing to this, the remaining
capacity will be displayed as less than the
card’s specified capacity, yet this is not
abnormal.

System Info.

You can check the recorder’s information on
the menu display. [Model] (Model Name),
[Version] (System version) and [Serial No.]
(Serial Number) appears on the display.

Refer to “Formatting the recorder
[Format]” (= P.94).

Menu setting method
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Menu setting method

Setting the recording scene « To confirm the respective recording
S scene settings, press the + or - button
[Rec cene] in the [Scene Select] display to select

the item you want to confirm, then
press the B button to confirm in
the setting confirmation display. To
end the setting confirmation display,
press the € button and the display
will return to the [Scene Select]

The recording setting can be selected from
the [Dictation], [Conference], [Lecture]
templates to suit the recording scene or
situation. You can also save a recording
setting of your choice.

n Select [Rec Scene] from the menu display.
on the [Rec Menu]. When [Scene Save] is selected:
« For details on how to enter the menu Besides the [Rec Scene] templates found
settings, please see “Menu setting intherecorder, you canalso save the menu
n method” (= P.65). settings of a recording you have set to
our choice.

Select [Scene Select] or [Scene {Scene Save] cannot be used during
= Save]. recording. While the recorder is paused,
2 enter the menu from the [Home] menu
H display, and then perform this setting.
= (@ Press the + or - button to select the
3 e [User Setting] you want to save.

3 (2 Press the > OK button to complete

“s._ the settings.

g Press the F3 (HOME) button to
complete the setting.

When [Scene Select] is selected:

(@ Press the + or - button to select the
recording scene you want to set.
(@) Press the > OK button to complete
the selection.
In [Scene Select], you can select a recording scene that is most suitable for the recording
scene or situation from three templates. The recording settings for the respective recording
scenes are as follows.
A Recording Scene
RIS, Ooff Dictation Conference Lecture
[Mic Sense] Middle Low Middle High
[Rec Mode] ST XQ HQ STXQ STXQ
[Rec Level] Auto Auto Auto Auto
[Zoom Mic] Off Off Wide Zoom
EN [Low Cut Filter] Off On On On
[VCVA] Off Off Off Off
80 [Standby] Off Off Off Off




Timer recording [Timer Re]

Timer recording is the function to execute a
recording at a set time. You can program up to
three desired settings (Preset 1-3) ([On/Off],
[Day], [Start Time], [Stop Time], [Rec Mode],
[Mic Sense], [MemorySelect], [Folder], and
[Keyword]).

I select [Timer Rec] from the menu
on the [Rec Menu].
For details on how to enter the menu

settings, please see “Menu setting
method” (=P.65).

Press the + or — button to selecta
preset number, and then press the
» OK or P button.

Press the + or — button to select
theitem to set, and then press the
» 0K or PP button.

@) 3 3
(G—) — ) —)

12:00 A

Middle

Select items you want to set from
among [On/Off], [Day], [Start Time],
[Stop Time], [Rec Mode], [Mic
Sense], [Memory Select], [Folder],
and [Keyword].

Menu setting method

On/Off] setting:

(@ Press the + or — button to select between
[On] and [Off].

& F2 3
(— — ] —

)

&

[On]:
Setting will be applied.
[Off]:
Setting will not be applied.
(2 Press the > OK button to exit [On/Off]
selection.

Day] setting:

(@ Press the + or — button to select from [One
Time], [Everyday], and [Every Week].

T 3 3
(C—) — ) —

(@)

sToP

[One Time]:
Records only once at the specified
time.

[Everyday]:
Records every day at the specified
time.

[Every Week]:
Make a recording at a set time on a
specified day of the week.
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Select [Every Week] and press the »OK
button to move to the selection of [Day].
Press the + or - button to select a day of

the week.

(2) Press the > OK button to exit [Day]

selection.

Start Time] and [Stop Time] setting:

Menu setting method

(DPress the + or - button to select a
recording mode.
(@Press the » OK or BB button.

#9143 be used with this setting

L The voice control function can
v

(v= P.107) (For DM-5).

)

(@ Press the P or < button to select
“Hour” and “Minute” in the [Start Time]
and “Hour” and “Minute” in the [Stop

Time].

4]
06:00-
[v]

(2 Press the + or - button to set.

(3) Press the »OK button to exit [Start Time]

and [Stop Time] selection.

(®Press the + or - button to select a
recording rate.

(@Press the > OK button to exit Recording
mode selection.

ll

Mic Sense] setting:

Regardless of the recorder’s microphone
sensitivity setting (5 P.67), timer recording
will start at a set microphone sensitivity.

F1 F2 F3

(C— | E— ] —)

Rec Mode] setting:

06:00 Pt
S

Midd e

Regardless of the regular [Rec Mode] (=
P.67), timer recording will start in a set

recording mode.

Press the + or - button to select from
[High], [Middle], and [Low].
(2)Press the » OK button to exit [Mic Sense]

selection.
& TR
(Y




Memory Select] setting:
(DPress the + or — button to select the
destination to save to (Memory).
(@Press the » OK button to exit [Memory
Select] setting selection.

Menu setting method

F1 F2 3

(C— | E— ] —)

Folder] setting:
(DPress the + or - button to select the
destination to save to (Folder).
(@Press the > OK button to exit [Folder]
setting selection.

T Pz 3
(C—) — ) —

Completing the setting:
Press the F2 (GO) button to

complete the setting.

o 11:55 ]
1

o>

Folder &

Keyword] setting:

Tag a keyword to file to be recorded using
the timer.

pe The voice control function can
bf1] be used with this setting
(== P.107) (For DM-5).

(DPress the + or - button to select the
desired keyword, and then press the
» OK button.

Programmed settings will be applied and
thedisplay will return to the presetnumber
selection menu. If the [On/Off] setting is
set to [On], [©] will appear on the display.
(@ When setting to [On]

06:00 P

To set other preset numbers, repeat the
abovementioned procedure.

When the B button is pressed in the
Select in Advance Menu, the settings
selected can be confirmed.
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If the recorder is in use at the preset start
time, the timer recording will start directly
after stopping the recorder.

Even if the power is turned off or the
recorderis puton Hold, timer recording will
start at a specified time.

If three timer recordings have the same
starting times, [Preset 1] has the highest
priority and [Preset 3] has the lowest.

If the starting time for timer recording and
alarm playback (v= P.87) is set for the same
time, timer recording will have priority.

If the batteries run out while recording
based onthe timer setting, the recorder will
stop recording. Check the battery power
before starting the timer recording.

If the [Time & Date] is not correct, timer
recording cannot be set at the specified
time, so make sure the [Time & Date] is
correct before setting timer recording. If
itis not correct, reset [Time & Date] (=
P.28).

The recorder will record in the built-in
memory [Folder A] when the microSD
card is selected as the recording
destination and the microSD card is not
inserted during Timer Recording.

Menu setting method

Setting the playback scene
[Play Scene]

Voice files recorded in the recorder and
music files downloaded from the PC can be
saved in the playback settings of your choice
to suit the different sound qualities and
playback methods.

n Select [Play Scene] from the menu
on the [Play Menu].

- Fordetails on how to enter the menu
settings, please see “Menu setting
method” (=P.65).

Press the + or — button to select
theitem to set, and then press the

» 0K or P> button.

& F2 3
(— — ] —

Scene Select

When [Scene Select] is selected:
(D Press the + or - button to select the
playback scene you want to set.
(2 Press the »OK button to complete the
selection.

Gl 3 3
(C—) — ) —




« After purchase, all the settings from
1to 5 of [User Setting] are the same
(initial settings). Register the user
settings in the [Scene Save] then
select playback scene.

« To confirm the respective playback
scene settings, press the + or - button
in the [Scene Select] display to select
the item you want to confirm, then
press the BB button to confirm in
the setting confirmation display. To
end the setting confirmation display,
press the <€ button and the display
will return to the [Scene Select]
display.

When [Scene Save] is selected:

You can save the menu settings of a play-

back you have set to your choice.

() Setting the menu of a playback in the
recorder to your choice.

(2 Press the + or - button to select the
[User Setting] you want to save.

(3 Press the > OK button to complete
the settings.

R G
| — ] — —
U

Press the F3 (HOME) button to
complete the setting.

Menu setting method

Guidance [Voice Guide]

This feature gives voice announcements
of recorder operating conditions and
file tag information (For DM-5). Adjust
the speed and the volume of guidance
announcements.

n Select [Voice Guide] from the
menu in [LCD/Sound Menu].

« Fordetails on how to enter the menu
settings, please see “Menu Setting
Method” (=P.65).

Press the + or — button to select
the item to set, and then press
the > 0K or PP button.

Menu Guide
E

oo

100

Menu Guide] setting:

Provides voice guidance for menu settings.
(DPress the + or - button to select between
[On] and [Off].
[On]:
[Menu Guide] will be provided.
[Off]:
Guidance will be canceled.
(@Press the » OK button to exit [Menu
Guide] selection.

poyjaw Huiyyas nuay H
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File Guide] setting:

Provides voice guidance for file tag
information.
(DPress the + or - button to select between
[On] and [Off].
[On]:
[File Guide] will be provided.
[Off]:
Guidance will be canceled.
(2Press the > OK button to exit [File Guide]
selection.

on01:04 (]

File Guide

@l P2 &
 e— — ) —)

Speed] setting:

Sets the voice guidance speed.

(DPress the + or - button to set the playback
speed.

(2Press the > OK button to exit [Speed]
selection.

\l\l

Menu setting method

Volume] setting:

Sets the voice guidance volume.

(DPress the + or - button to select from
[Volume5], [Volume4], [Volume3],
[Volume2], and [Volume1].

(@Press the »OK button to exit [Volume]
selection.

e 01:05 o]

Gl P2 3
(— ] — ] —

Press the F3 (HOME) button to
complete the setting.

« The starting tune/closing tune when the
power is turned On/Off (== P.26) can be
canceled if you set the guidance to [Off].

« Set the starting tune/closing tune at the
guidance [Volume] setting.

- If [Play Speed] has been changed, the
[Speed] setting in the [Voice Guide]
settings cannot be changed.



Alarm playback function [Alarm]

Thealarm playback function can be set to play
a selected file at a pre-set time.

You can program up to three desired settings
(Preset 1-3) ([On/Off], [Day], [Start Time],
[Volume], [Alarm Sound] and [Playback
File]).

I select [Alarm] from the menu on
the [Play Menu].
For details on how to enter the menu

settings, please see “Menu setting
method” (==P.65).

Press the + or — button to select a
preset number, and then press the
» OK or P button.

F @ &
 e— — ) —)

H Press the + or — button to select
the item to set, and then press the
» OK or PP button.

Select items you want to set from
among [On/Off] [Day] [Start Time]
[Volume] [Alarm Sound] [Playback
File].

Menu setting method

On/Off] setting:
(DPress the + or — button to select between
[On] and [Off].
(@Press the »OK button to exit [On/Off]
selection.
[On]:
Setting will be applied.
[Off]:
Setting will not be applied.

| S—

[[

[Day] setting:

(DPress the + or — button to select from
[One Time], [Everyday], and [Every
Week].

[One Time]:
Alarm Playback will be performed
only once at the specified time.
[Everyday]:
Alarm Playback will be performed at
the specified time every day.
[Every Week]:
Make a Alarm Playback at a set time
on a specified day of the week.

poyjaw Huiyyas nuay H
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Menu setting method

Select [Every Week] and press the » OK Volume] setting:
or PP button to move to the selection of (@) Press the + or - button to adjust the

[Day]. Press the + or — button to select a day volume. Press the B OK button to check
of the week.

. the volume.
@Press tAhe » OK button to exit [Day] (2) Press the »OK button to exit [Volume]
selection. selection.
Start Time] setting: ||

3 be used with this setting

The voice control function can 1
V
(= P.107) (For DM-5).

(@ Press the P or € button to select
“Hour” and “Minute” in the [Start Time]
and “Hour” and “Minute” in the [Stop

Time]. Alarm Sound] setting:

(D Press the + or - button to select an alarm
sound from among [Alarm1], [Alarm2]
and [Alarm3]. Press the » OK button to
check the alarm sound.

(2 Press the »OK button to exit [Alarm
Sound] selection.

Gl P2 3
(— ] — ] —

(2) Press the + or - button to set.
(@) Press the » OK button to exit [Start Time]
selection.

&) 3 3
(G— | E— | —)




Playback File] setting:
(@ Press the + or - button to select from [No
File Play], [File Select].

[No File Play]:
Sounds alarm only.
If [No File Play] has been selected,
proceed to the procedure listed
under “Completing the setting”.

[File Select]:
Plays back a selected file after the
alarm.

When [File Select] is selected:

(@ Press the + or — button to select the
memory with the file to be played as
an alarm, and then press the » 0K or

Menu setting method

(3 Press the + or — button to select a
folder, and then press the » 0K or
PP button.

(@ Press the + or — button to select the
file to be played as an alarm, and then
press the » 0K button.

»» button.
T 7
]] (— — ] —

(2 Press the + or — button to select a
folder, and then press the » 0K or
> button.

\l\l

Recorder

Completing the setting:

Press the F2 (GO) button to
complete the setting.

poyjaw buyyas nuay H
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Programmed settings will be applied
and the display will return to the preset
number selection menu. If the [On/Off]
setting is set to [On], [(] will appear on
the display.

(@ When setting to [On]

pn01:30 {4

Alarmm

®

Preset |

To set other preset numbers, repeat the
above mentioned procedure.

When the BB button is pressed in the
Select in Advance Menu, the settings
selected can be confirmed.

If [Everyday] is selected, the alarm will
sound at the scheduled time every day
unless alarm playback is canceled.

The alarm will sound for five minutes

and then stop. Even if a file is selected for
Alarm Playback, it will not be automatically
played when the alarm sounds.

If three alarm playback have the same
starting times, [Preset 1] has the highest
priority and [Preset 3] has the lowest.

If the recorder is in use or if operations are
being performed at the scheduled time,
the Alarm Playback function will not be
available.

The alarm will sound at the scheduled
time even if the power is turned off or the
recorder is set to Hold mode. The recorder
begins to play the selected file when you
press any button, and stops playing when
you press the STOP button.

Menu setting method

« Ifthe selected file is moved, erased or the
microSD card removed, file playback will
not be performed and only the alarm will
sound.

« If the starting times for timer recording and
alarm playback are set for the same time,
timer recording will have priority (= P.81).



Moving/Copying files
[File Move/Copy]

Files saved in the built-in memory or the
microSD card can be moved or copied
within the memory. Files can also be moved
or copied between memory.

Il select the folder where the file
you want to move or copy is
saved (*= P.53 to P.59).

Select [File Move/Copy] from the
menu on the [File Menul].

« Fordetails on how to enter the menu
settings, please see “Menu Setting
Method” (=P.65).

Press the + or — button to select
the position to move or copy the
file to.

n Press the » OK or PP button.

Move a file in the built-in
memory or microSD card
to another folder within
the built-in memory.

[move > memory]

Menu setting method

Copy a file in the built-in
memory or microSD card

Isopyiginiciospl to another folder in the

microSD card.

Press the + or — button to select
the number of files to move or

copy.

an08:43 (]

1009041001

[file] ?elect only the specified

ile.

[Selected files] Select multiple files.

Select allfiles in the

[All files] folder.

A Press the > 0K or BB button to
move to the respective setting.

When you select [1file]:
(@ Press the + or — button to select the
file you want to move or copy.
(2 Press the > OK button to select the
file. Proceed to Step 8.

@ 2 3
(— ] — ] —

Copy a file in the built-in|
memory or microSD card to|
another folder within the|
built-in memory.

[copy > memory]

Move a file in the built-in
memory or microSD card
to another folder in the
microSD card.

[move > microSD]

00904_1001 . vma
41002
14_100:

1
1
101
1
1
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When you select [Selected files]:
(@ Press the + or — button to select the
file you want to move or copy.
(2 Press the »> OK button to check the
file(s) selected.

l\l

v VOG_1001041006.ma
;- 100104_1€
1001041

4_1( a
a

When you select [All files]:
When all files are selected, all the files
in the folder will be automatically
selected and the recorder will move
to the [Folder to move] display.
Proceed to Step 8.

Press the F2 (GO) button.

I3 Music

ﬂ Press the PP, |4, + or —
button to select the folder you
want to move or copy the file to.

Menu setting method

[ Press the » 0K button.

« [Moving!] or [Copying!] will appear
on the display and moving or copying
will start. During the process, the
progress status will be shown in
percentage. The process is completed
when [File move completed] or [File
copy completed] is displayed.

The recorder cannot copy when the
memory capacity is not sufficient.

The recorder cannot move or copy when
the number of file exceeds 999.

Do not remove the battery during moving
or copying. This may damage the datas.

A file cannot be moved or copied to the
same folder.

When the operation is cancelled during
moving or copying, only the file that is
being moved or copied is effective, all
other files will become not effective.

Files which are locked (= P.75) will remain
so even after they are moved or copied.
DRM files cannot be moved or copied.
Files cannot be moved or copied directly
under the [Recorder] folder.



Dividing files [File Divide]

Files with large capacities and long
recording times can be divide so that they
are easier to manage and edit.

n Only PCM and MP3 files recorded
on this recorder can be divide.

n Select the file you want to divide
(v P.53 to P.59).

Start Playback or fast-forward
the file, and stop the playback at
divide position.

In the file display, the stop position
becomes the divide position.
During playback, press and hold the
P or 4 button to fast-forward
or rewind (v= P.47).

Itis useful to setindex marks on
marking in advance at the divide
position (== P.51).

Select [File Divide] from the menu
on the [File Menu].

For details on how to enter the menu
settings, please see “Menu setting
method” (r= P.65).

A file cannot be divide during an

operation such as playback by the
recorder.

A Press the + button to select

[Start], and then press the » 0K
button.

Menu setting method

[Dividing!] will be displayed and
file splitting will start. Splitting
is completed when [File divide
completed] is displayed.

«+ The file divide cannot be done when the
file list is displayed.

«+ The recorder cannot divide files when the
number of files in the folder exceeds 998.

« Locked files (== P.75). cannot be divide.

« After a file has been divide, the original file
will be renamed [File name_1.wav] and
the new file will be named [File name_
2.wav]

- If afile has an extremely short recording
time, it may not be divide even ifitis a
PCM file.

« Do not remove the battery during dividing
file. This may damage the data.

poyjaw buyyas nuay H
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Formatting the recorder [Format]

If you format the recorder, all files
will be removed and all function
settings will return to defaults except
date and time settings. Transfer any
importantfiles toacomputerbefore
formatting the recorder.

n Select [Format] from the menu on
the [System Menul].

For details on how to enter the menu
settings, please see “Menu setting
method” (= P.65).

Press the + or — button to select
the recording media to format,
and then press the > 0K or P>
button.

Press the + button to select
[Start], and press the > OK button.

09:36 {a]

Format

After the [Data will be cleared]
message is on for two seconds,
[Start], [Cancel] will turn on.

Menu setting method

Press the + button again to select
[Start], and then press the » 0K
button.

an09: 37 o]

Format

Formatting begins and [Formatting !]
flashes on the display.

[Format Done] appears when
formatting ends.

« When an microSD card is inserted in the
recorder, be sure to confirm the recording
media as either [Built-in] or [microSD] so
that there is no mistake (v P.77).

« Never perform operations such as the
following while processing, as they may
damage the data. In addition, carefully
check the remaining battery level in order
to ensure that the battery will not run out
while processing.



( Unplugging the AC adapter while
processing.
(2 Removing the battery while processing.
(3 Remove the microSD card during
processing when [microSD] is
being used as the recording media.
Performing any of these operations
may damage the data.
Never format the recorder from a PC.
When the recorder is formatted, all the
saved data, including locked files and
read-only files, are erased.
When returning the settings for the
functions to their initial settings, use
[Reset Settings] («= P.78).
Formatting on the recorder will be
Quick Format. If you format the microSD
card, information of file management
is refreshed and the data inside the
microSD card is not deleted completely.
Formatting or deleting the contents of
the microSD card or built-in memory does
not completely erase the data. When you
dispose of media, we recommend that
you take measures to prevent the loss
of sensitive data, such as destroying the
media before disposal.

Menu setting method
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Schedule settings [Audio Diary]

This recorder has a calendar function.
Simple scheduling can be performed.

Displaying the calendar

n From the [Home] menu display
select [F] Audio Diary], and then
press the > 0K or & button.

A monthly calendar display is
displayed.

2010.MAR

SunMonTueWed Thu Fri Sat
01 02 03 04 05

07 09 10 11 12

14 15 16 17 18 19 20

21 22 23 24 25 26

28 29 30 31

08

Mon

Switching the calendar display

Itis possible to switch the calendar screen
between a monthly, weekly, and daily
display.

n In the calendar display, press the
F3 (MENU) button.

F2

] ()

.=

Press the + or — button to select
[Fia DISPLAY], and then press the
» 0K button.
The calendar display switches to a
weekly display.

T 7z 3
(— ] — ] —

2010.MAR

07 Sun

09 Tue
10 Wed

+ The calendar does not display national
holidays.

11 Thu
12 Fri

13 Sat
HOME

«  From the weekly display, move the
cursor to the day you want to display.
Press the 0K button to switch to the
daily display.

« Ifthe calendar function is exited, the
monthly display is displayed the next
time the calendar display is opened.



Schedule settings [Audio Diary]

Operations at the calendar display Add a schedule

n From the calendar display, press
the PP, |4«, + or — button to

Operations at the monthly display:

(F1] button The display returns to the select the date to which you want
[Home] menu display. to add a schedule, and then press
the F3 (MENU) button.
Changes the month that
is displayed. At the popup
[F2] button menu display, press the +
or - button to select the
previous or next month.
SunMonTueWedThu Fri Sat
1 01 02 03 04
[F3] button ;rﬁeedr;’;;rlg;‘wﬂl appear on 07 [ 09 10 11
14 15 16 17 18
21 22 23 24 25

Operations at the weekly display: Select [ Audio DiaryMenul],

Operations at the daily display:

and then press the > 0K or B>p>|
The display returns to the button.
[F1] button [Home] menu display.
&l @ 5
[F2] button Disables this function. T —
—
STOP. VoL REC g
The menu will appear on
[F3] button the display.

B Press the + or — button to select
[New], and then press the »OK or

[F1] button The display returns to the »» button.
weekly display.
P 3 73
[F2] button Displays the details of the (— ) — ) —
daily schedule.
The menu will appear on
[F3] button the display.

[K1e1q o1pny] sbunyas sjnpayds
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A Move the cursor to the item you
want to set, and then press the
» OK or P button.

l\l

[ 10.03 08
09:55 AM

09:55 Alt

Date] setting:

.’ The voice control function can
b5:] be used with this setting
(= P.107) (For DM-5).

Schedule settings [Audio Diary]

[Repeat] setting:

(D Press the + or — button to select the item
to set, and then press the > OK button.

« You can specify the event frequency from
[One Time], [Everyday], [Every Week],
[Every Month], and [Every Year].

| S—

Gl P2 3
(— ] — ] —

(@ Press the P>, €, + or - button, set
the “Year”, “"Month”, and “Date”. Press the
» OK button.

[A]
2010.03.08
v}

Start Time] and [Stop Time] setting:

793 be used with this setting

The voice control function can ]
V
(r= P.107) (For DM-5).

(@ Press the P>, €, + or - button, set
the “Hour” and “Minute” in the [Start
Time] or [Stop Time]. Press the > OK
button.

Everyday

Keyword] setting:

., The voice control function can
bS] be used with this setting
(== P.107) (For DM-5).

(@ Press the + or - button to select the
desired keyword, and then press the
»OK.

| S—

 e— ] G— ) —)




Keyword list:

Sets a keyword from the preset template.

Car Train Plane
Bus Work Interview
Business trip Conference Lecture
Class Memo Record
tzlceoprz?:ge Diary Conversation
Favorites School Hospital
Hobby Meal Shopping
Travel Lesson ﬁ:?\;nui;]g:
Drive Sport Camping
Music Family Kids
Partner Friend Event
Holiday Date Birthday
Payday

Alarm] setting:

Schedule settings [Audio Diary]

(@ Press the + or — button to select [Alarm]
setting, and then press the » OK button.

[Off]:

Disables this function.

[1]to [3]:

Select the alarm sound for the alarm

notification.

| —

T 3 3
(C—) — ) —

on 10: 12 ]

Completing the setting:

Press the F2 (GO) button to
complete the setting.

an 10: 14 ]

2010.FEB
SunMonTueWed Thu Fri
ad 02 03 04
9 10 11
14 16 17 18
21 22 23 24 25
28

« Aday with a schedule is underlined.

« A maximum of 1000 events can be

scheduled.
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Editing the schedule

The details of scheduled events can be
edited.

n From the calendar display, press
the PP, |44, + or — button to
select the day of the event you
want to edit, and then press the
» 0K button.

2010.F

SunMonTueWedThu Fri Sat
01 02 03 04

07 09 10 11

14 15 16 17 18

21 22 23 24 25

Press the + or — button to select
the event you want to edit, and
then press the F3 (MENU) button.

[A1e1q o1pny] sbuiyas ajnpayds !

Select [] Audio DiaryMenu],
and then press the > 0K or PP
button.

an 10:19 {]
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Schedule settings [Audio Diary]

Press the + or — button to select
[Edit], and then press the > OK or

For the procedure for changing event
details, please see “Add a schedule”.



Schedule settings [Audio Diary]

Deleting a schedule Press the + or — button to select
[Delete], and then press the » 0K
Delete the contents of a scheduled event. or P button.

n From the calendar display, press
the PP, I4«, + or — button to
select the day of the event you
want to delete, and then press the
» 0K button.

2010.FEB
SunMon TueWed Thu Fri Sat
01 02 03 04 05

07 09 10 11 12

14 15 16 17 18 19

21 22 23 24 25 2 23 Press the + button to select

* [Start], and then press the > 0K
button.

Press the + or — button to select
the event you want to delete, and
then press the F3 (MENU) button.

2010.FEB.O8

[K1e1q o1pny] sbunyas sjnpayds H

A single scheduled event is deleted.

Select [[F] Audio DiaryMenul],
and then press the > 0K or P>
button.

an 10: 19 ]|
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Formatting the schedule

Register to remove all the contents of
schedule to initialize.

Il From the [Home] menu display
select [[F] Audio Diary], and then
press the »OK or B> button.

In the calendar display, press the
F3 (MENU) button.

Schedule settings [Audio Diary]

Press the + or — button to select
[Format], and then press the » 0K
or PP button.

2010.FEB.08

|

Press the + button to select
[Start], and then press the » 0K
button.

1 2
(—)] e (—)
@ =) 2010.MAR
SunMon TueWed Thu Fri Sat
01 02 03 04 05
07 09 10 11 12
14 15 16 17 18 19
21 22 23 24 25 26
28 29 30 31

[A1e1q o1pny] sbuiyas ajnpayds !

Select [EF] Audio DiaryMenu],
and then press the > 0K or PP
button.

Audio DiaryMenu

EN
102

[Format Done] appears when
formatting ends.



Viewing images (For DM-5)

This recorder can connect to a digital
camera and import images.

To see a list of recommended
external devices (digital cameras)
that can connect to this recorder,
please visit our web site.

Importing images

n From the [Home] menu display,
select [[2] Picture], and then
press the »OK or B> button.

\l\l

L]
J
®
jan]
2]

s@

Press the + or — button to select
[Import], and then press the » 0K
or P button.

@] 3 75
(C— | E— ] —)

Press the + or — button to select
[microSD] or [USB], and then press
the > 0K or P> button to set
(complete) the media you want to
import.

JPEG image files located in the DCIM
folder can be imported.

Import images stored on

[microSD] a microSD card to this re-
corder.

Importimages stored on a

[USB] connected digital camera

to this recorder.

Press the + or - button to select
[Built-in] or [microSD], and press
the »> 0K or P>| button to set
(complete) the memory for
importing destination.

Press the + button to select [0K],
and then press the > 0K button.

(N ] n02: 11 ]

Picture

The display changes to
[Synchronizing] and import starts.

(S-W@ 104) sabewn buimaip H
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Viewing images

n From the [Home] menu display,
select [[2] Picture], and then press

the » OK or P button.

Viewing images (For DM-5)

Select [IMAGE] folder, and then
press the » 0K or P button.

l\l

Picture

Press the + or — button to select

Dates on which images were taken
are displayed as a list.

Press the + or — button to select
a date images were taken, and

[Browse], and then press the > 0K then press the » 0K or P>
or PP button. button.
(1 1 (| | )

B Press the + or — button to select

[Built-in], [microSD] or [USB],
and then press the > 0K or B>

button.

n Press the + or — button to select
aimage file, and then press the
> OK or PP button.

&) 3 3
(G— | E— | —)

[N ] an 10:36 {id]
Picture




Press the PP or €4 button to
move to the next image file.

WEHU

Viewing images (For DM-5)

Erasing aimages

n From the [Home] menu display,
select [[2] Picture], and then
press the > 0K or P button.

Picture

Press the + or — button to select
[Browse], and then press the > 0K
or P button.

0211 ]

Picture

Press the + or — button to select
[Built-in], [microSD] or [USB],
and then press the » 0K or PP
button.

(S-W@ 104) sabewn buimaip H
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Viewing images (For DM-5)

n Select [IMAGE] folder, and then Press the + or — button to select
press the > 0K or P button. [File Erase], and then press the

» OK or PP button.

Dates on which images were taken
are displayed as a list.

n Press the + button to select
[Start], and then press the > 0K

Press the + or — button to select button.
adate images were taken, and « Thedisplay changes to [Erase!] and
then press the > OK or >p>1 erasing will start. [Erase Done] is
button. displayed when the file is erased.
For details on how to erase afile,
please see “Erasing from the file
H—m list display” (=P. 61), “Erasing All
(G| G| G

Filesin a Folder” (=P. 62), “Erasing a
folder” (==P. 63).

n Press the + or — button to select
the image file you want to erase,
and then press the F2 (ERASE)

button.

.l\_'
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Using voice recognition (For DM-5)

This recorder is equipped with a voice
recognition function. This function allows
complicated key inputs such as date and
time settings, keyword entry, and folder
name changes to be performed by voice. In
addition, it is possible to use voice command
shortcuts to jump to the various modes and
menu settings of the [Home] menu display.

Using voice control

A When the [(E] mark is displayed at
the menu setting screen, press and
hold the VOICE button while saying
the setting you want to enter.

« The following explanation of the
voice control function provides
examples of actual operations that
can be performed using this recorder.

When you are setting the
“hour”, “minute”, “year”,
“month”, and “day” in the
[Time & Date] settings,
say the “year”,“month”and

[Time&Date] “day” or “time” you want
Using voice to enter.

recognition for | Example: When entering
time entry February 10,2010

February 10,
2010 10:20 AM

When entering the [Start
Time] and [Stop Time] in
the [Timer Rec] settings,
say the times.

Example: When the start
time is 9:30

[Timer Rec]
Using voice
recognition for
time entry

Example: When the end
time is 11:00

[Timer Rec]
Using voice
recognition for
keyword entry

Say a “Keyword” that is in
the template.
Example: When setting
“Conference”.

[Folder Name]
Using voice
recognition for
settings

When changing a [Folder
Name], say a “word” in the
template.

Example: When changing
the name to “Work”.

[Alarm]

Using voice
recognition for
time entry

When setting the [Start
Time]settinginthe [Alarm]
settings, say the “time”.
Example: When the start
time is 6:30

[Schedule
Setting]

Using voice
recognition for
time entry

When entering the [Start
Time] and [Stop Time]
while [Add Schedule] set-
tings, say the “times”.
Example: When the start
time is 9:30

Example:When the end
time is 11:00

[Schedule
Setting]

Using voice
recognition for
keyword entry

Say a “Keyword” that is in
the template.
Example: When setting
“Conference”.
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Using voice commands

Using voice recognition (For DM-5)

n While the recorder is paused at
the [Home] menu display, press
the VOICE button and say a voice
command word.
+ Voice commands cannot be used

when [Recorder] mode is running or

during an operation.
Voice commands list:

Recorder Music Podcast
Picture Book Schedule
Preferences Audible

« The following explanation of the
voice command function provides
examples of actual operations that can
be performed using this recorder.

(S-W@ 104) uonytubodal adion buisp !

Transition to
each mode

Except for recorder mode,
say the name of the mode
you want to launch to jump
to that mode.

Example: When jumping to
[Music] mode

Music 2

The mode changes to
[Music] mode.
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Using the Olympus Sonority

Saving files in your PC

By being connected to a PC, the recorder
enables you to do the following:

+ Playback voice files on your PC (v= P.124).
Voice files recorded using the recorder can
be played using the “Olympus Sonority”
softwareincluded on the provided CD-ROM
(= P.113)or "Windows Media Player" (&=
P.138).

+ Voice files recorded on the recorder can be
played and managed on the PC using the
“Olympus Sonority”.

» Using the “Windows Media Player”, the
stored WMA or MP3 files on your PC can be
transferred and played back on this recorder
(v P.141).

« If an upgrade (Option) to the “Olympus
Sonority Plus” is executed or a Music
Editing Plug-in is added (Option), various
additional functions can be utilized (=
P.136).

Precautions on using the recorder connected
toaPC

+ When you are downloading a file from
the recorder or uploading a file to the
recorder, do not remove the USB cable
even if the screen is indicating you can.
Data is still being transferred while the LED
indicator light is blinking. When removing
the USB cable, be sure to follow the
description in = P.111. If the USB cable is
removed before the drive is stopped, data
may not be successfully transferred.

« OnaPC, do not format the drive of the
recorder. Initialization is not successfully
achieved on a PC. For initialization, follow
the instructions in the [Format] display of
the recorder (== P.94).

- Folder (directory) names displayed by
file management tools such as Explorer
in Microsoft Windows and Finder in
Macintosh are different from the folder
names that can be set with the recorder or
the “Olympus Sonority”.

« Iffolders or files stored on the recorder
are moved or renamed by using a
file management tool in Windows
or Macintosh, the order of files may
be changed or files may become
unrecognizable.

- Data can be written or uploaded to the
recorder even though the attribute of the
recorder drive is shown as Read-only by
the operating system of the PC.

« As the noise may cause adverse effects on
electronics devices nearby the recorder,
unplug the external microphone and
earphone when you connect the recorder
toaPC.

Important notice on the explanation of
software functions

Function items that can be used in Windows
will be displayed as (IR and function
items that can be used in Macintosh will be
displayed as (EEIIEED. Items that only have

or (D indicated can only be
supported by the target system.

Jd inof ui sajiy buireg
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Operating environment
| Windows

Operating System:
Microsoft® Windows® XP Service Pack 2, 3
Microsoft® Windows® XP Professional x64
Edition Service Pack 2
Microsoft® Windows Vista® Service Pack 1,
2 (32bit/64bit)
Microsoft® Windows® 7 (32bit/64bit)
CPU:
32 bits (x86) of 1GHz and above or 64 bits
(x64) processor
RAM:
512 MB or more
Hard drive space:
300 MB or more
Drive:
CD-ROM, CD-R, CD-RW, DVD-ROM drive
Browser:
Microsoft Internet Explorer 6.0 later
Display:
1024 x 768 pixels or more, 65,536 colors
or more (1,6770,000 colors or more is
recommended)
USB port:
One or more free ports
Others:
+ Audio device
« Environment where the Internet can be
utilized.

Operating System:
Mac OS X 10.4.11 - 10.6
CPU:
PowerPC® G5 or Intel Multicore Processor
1.5 GHz and above
RAM:
512 MB or more
Hard drive space:
300 MB or more
Drive:
CD-ROM, CD-R, CD-RW, DVD-ROM drive
Browser:
Macintosh Safari 2.0 later
Display:
1024 x 768 pixels or more, 32,000 colors
or more (1,6770,000 colors or more is
recommended)
USB port:
One or more free ports
Others:
«+ Audio device
« Environment where the Internet can be
utilized (Quick Time version 7.2 or more is
recommended).

Windows:

« The support service will not cover if your
PC has been updated from Windows
95/98/Me/2000 to Windows XP/Vista/7.
Any failure on a self-modified PC will

not be covered under the operational
warranty.

Macintosh:

« Some functions in "Olympus Sonority"
require QuickTime 7.2 and above.
The latest version of QuickTime can
be obtained from the MacOS Software
Update.



Connecting to your PC

Connecting to your PC

(D D

n Turn the recorder’s power ON.

Connect the USB connection
cable to the USB port of the PC.

Make sure that the recorder is
stopped, and then connect the
USB cable to the connecting port
on the bottom of this recorder.

« Besure to use the included dedicated

[Remote (Storage)] is displayed
on recorder if the USB cable is
connected.

« When the recorder is using the USB
connection setting, it will not be
connected to the PC when [AC]
is selected. Select [PC] in the USB
connection setting (= P.77).

Windows:

When you connect the recorder to a
Windows and open [My Computer], it will
be recognized by the drive name of the
productname. IfamicroSD cardisinserted,
[Removable Disc] will be displayed.

Macintosh:

When you connect the recorder to a Mac
OS, itwill be recognized by the drive name
of the product name on the desktop. If a
microSD card is inserted, [NO NAME] will
be displayed.

cable for the USB connecting cable. If
any other company'’s cable is used, it will
be the cause trouble. Also, please do not
connect this dedicated cable to any other
company’s product.

« When connecting the recorder through

an USB hub the operation may become
unstable. In such cases, refrain from using
a USB hub.
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Disconnecting from your PC

Il Click [ = ] on the task bar
located at the lower-right corner
of the screen. Click [Safely

remove USB Mass Storage Device].

The drive letter will differ depending
on the PC being used.

Confirm that the recorder LED
indicator light is gone before
disconnecting the USB cable.

« The LED indicator light will light up
(orange) in case of charging, however
you can still disconnect the USB cable
in such condition.

3d ino£ 03 buip>auuo) !

n Move the drive icon for this
recorder that is appear on the
desktop to the garbage bin by
Drag & Drop it.
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Connecting to your PC

Confirm that the recorder LED
indicator light is gone before
disconnecting the USB cable.

« The LED indicator light will light up
(orange) in case of charging, however
you can still disconnect the USB cable
in such condition.

« NEVER disconnect the USB cable while the
LED indicator light is flashing. If you do,
the data will be destroyed.

« When the recorder is connected to a PC,
the power will be supplied from the USB
cable.

« Refer to the user’s manual for your PC
regarding the USB port on your PC.

« Be sure that you connect the USB cable

either directly to the USB port on your PC.

Be sure to push the cable connector all the

way in. Otherwise, the recorder may not

operate properly.

« Cancel Hold mode.



Functions available in the Olympus Sonority

Various functions such as file management and editing are installed in the “Olympus
Sonority”. For information on operating procedures and detailed settings, please refer to the
respective items on online help (= P.118).

Waveform editing function

Using the Waveform Editing Function Tab, you can easily process the voice data. In the
Waveform Editing Mode, you can also delete unnecessary parts, paste and re-save the data.

One-touch effect function

Using the One-touch Effect Function, you can easily apply special effects to the voice file and
carry out noise reduction in any specified area.

Send voice files with E-mail

Voice files are stored in the [Message] folder on the hard disk. Voice file can be sent as an
E-mail attachment.

Changing user ID
The user ID will be automatically given to files that are recorded with the recorder.

Changing a folder name

Kyriouos sndwik|Q ay3 u1 3jqejieae suondUNy E

You can change a folder name. A folder name can be up to 62 characters long and cannot use
\/*7"<>.

When changing the folder name using an OS in a language not supported by the main
device, the words may sometimes be garbled.

Editing file comments

Itis possible toadd comments to the files downloaded from the recorder by using the “Olympus
Sonority”.

Changing the file format to other format*

The current saved file format can be changed to other formats.

Joining files*

In “Olympus Sonority” , designated multiple voice files can be joined and one voice file can
be created.
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Functions available in the Olympus Sonority

Splitting files*

One designated voice file can be split into the two files in “Olympus Sonority”.

Import files using Olympus Sonority

« Import Podcast content from the Internet to a computer.
= Please see “About Podcast” (== P.127) for details.
« Import DAISY content from the Internet to a computer.**
w Please see “About DAISY (For DM-5)" (x= P.132) for details.

* Changing to a MP3 format upgrade to the “Olympus Sonority Plus” is necessary (v P.136).
** DAISY 2.0/2.02 content is supported (== P. 132).



Installing Software

Before you connect the recorder to your PC and use it, you must first install the “Olympus
Sonority” software from the included Software CD.
Be sure to confirm the following before installation:

« Exitall running applications.
+ You need to log on as an Administrator.

n Insert “Olympus Sonority” into
the CD-ROM drive.
The installation program will start

automatically. Once the program
starts, jump to step 4. If it does not,

follow the procedures in steps 2 and 3.

Opening contents in the CD-ROM
with [Explorer].

Double-click [Setup] in the CD-
ROM.

When the “Olympus Sonority”
launch screen is displayed, click
the desired language to select it.

When [Olympus Sonority Setup]
is clicked, the Installer Opening
display will start up. Follow the
Installer Wizard instructions.

version 1.1 ’

Olympus Sonority Setup

H Confirm your acceptance of the
terms of the Licensing Agreement.

« You must accept the terms of the
Licensing Agreement to install
“Olympus Sonority”. After checking
the [Agree] box, click [Next].

[Registration of User Registration
Information]

« Please enter your name, company
name and serial number which is
listed on the separate sheet. Click
[Next] after entering.

ﬂ [Select Setup Type]

« Theinstallation destination can be
changed. Click [Next] if you do not
want to change (Select [Custom] if
you want to change).

ﬂ [Start Installation]

« Click [Install] to start installing. Do
not carry out other operations before
the installation is completed and the
[Complete] display is displayed.

m [Installation Complete]

« When the installation is completed,
the completed [Install Shield]
display will be displayed.

« Toconnect the recordertoaPC,
refer to “Connecting to your PC”"

(s P.111), to start up the Olympus
Sonority, refer to “Running Olympus
Sonority” (5= P.119).

a1emyyos buijessuj E
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n Insert “Olympus Sonority” into

the CD-ROM drive.
Proceed to step 3 when the content of
CD-ROM is displayed, and go to step 2
and 3 when nothing is displayed.

Opening contents in the CD-ROM

with [Finder].

Double-click [Setup] in the CD-

ROM.

n When the “Olympus Sonority”

iy

i
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launch display is displayed, click
the desired language to select it.

When [Olympus Sonority Setup]
is clicked, the installer opening
display will start up. Follow the
Installer wizard instructions.

n Confirm your acceptance of the
terms of the licensing agreement.

You must accept the terms of the
licensing agreement to install
“Olympus Sonority”. After checking
the [Agree] box, click [Next].

Installing software

[Changing the Installation
Destination]

The installation destination can be
changed. Click [Next] if you do not
want to change (Select [Change
Installation Destination] if you want
to change).

ﬂ [Start Installation]

When the installation is completed,
the completed [Installer] display will
be displayed.

To connect the recorder to a PC, refer
to “Connecting to Your PC" (x= P.111),
to start up the “Olympus Sonority”,
refer to “Running Olympus
Sonority” (5= P.119).

After starting up the “Olympus
Sonority”, the serial number entry
dialog box will appear. Serial number
which is listed on the separate sheet.
After entering, click [OK] and the
“Olympus Sonority” will start up.



Uninstalling software

To uninstall any of the software component of the “Olympus Sonority” software installed on
your PC, follow the steps below.

n Exit “Olympus Sonority”. n Exit “Olympus Sonority”.
Select [Start] from [Control Panel] Open [Finder] and double-click
menu. the [SonorityUninstaller.pkg] in
th lication folder.
Click [Add/Remove programs] in ¢ application folder
the control panel window. The Uninstaller will start up.

. .. Follow the wizard instructions.
When the installed application

listis displayed, select [Olympus n When the administrator
Sonority]. password is asked, enter the

d then click [0K].
Click [Change/Remove]. password then click [0K]
Uninstall will start and when

A confirmation of deleting the file. [Successful] is displayed, click
Click the [OK] button to start [Close].
uninstalling. An additional message
may appear, if so, read it carefully and
follow the instructions given.

When the [Maintenance
Complete] display is displayed,
click [Finish] to complete
uninstalling.

Files left after uninstallation

The voice files you made are stored in the [MESSAGE] folder. If you dont need them, delete
them.

You can confirm the location of the [MESSAGE] folder by clicking [Options] in the [Tools]
menu before uninstalling.

a1emyyos buipjeysuup
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Using online help
 Windows l Macintosh]

To open Online Help, you have the following options.
+ While “Olympus Sonority” is running, select [Contents] from the [Olympus Sonority Help]

menu.

Search by Contents Search by Keyword

n Once the Online Help display
appears, click the Contents tab.

Double-click the @ icon of the
desired topic heading.

Double-click the @ icon of the
desired topic.

« Anexplanation of the topic is
displayed.

m Basic Operations

(@ Dovmloading a Fila
@Dawnloadmg All Files
@Dawnloadmg Files in a Specified

Olympus Sol

Folder Olympus Sonarity is
— . audio files with an C
Browwsing screen, wi

Ly als which i Used 1o edi
@ Making a New Recording The Browsing scree
@ Editing a File audio files between

and tone contral wh
and join audio fles.

The Waveform Editi
adding a recording,

the Browsing and &1
editing of audio fles
Qlyrrpus Sonarity he

@ Managing Files and Folders
@ Various Uses
@ Device Management Functions
@ Troubleshooting
@ Appendix
ENindex

[l open Online Help and click the
[Index] item.

« Matching keywords are located
automatically.

Click keyword.

« An explanation of the topic s
displayed.

The Wavetaorm Eciti
adding a recording,

the Browsing and Ei
editing of audio files
Olympus Sonority he

@ Device Management Functions
@ Troubleshooting
@ Appendix

_ -

Olympus Sonority Help

Az
futomatic Starting

Colurns to Dislay

Comment ( )

Customize

Device.

» For more information on menus and operations, refer to Online Help. You will be able to
use Online Help after Olympus Sonority is installed.



Running Olympus Sonority

By connecting the recorder to your PC, you can automatically start the application.

Disabling automaticstart

n Right click on the [D]] of the
taskbar on the lower right of the
display, and select [Setting].

The application which enables setting
will be displayed by dialog.

Click the [[*]] of the [Olympus
Sonorityl.

The check mark on [Olympus
Sonority] disappears. For automatic
start, select and click “Olympus
Sonority” to reinstate again.

n Start Windows.

Click the [Start] button, select
[All Programs], then [Olympus
Sonorityl.

After start up, a [J]] icon will be
displayed in task bar in the bottom
right of the display.

Disabling automaticstart

A From the menu bar, click (8]
[System Environment Setting] =

ig.
The setting dialog box will appear.

Turn the automatic start up in the
setting check box to [OFF].

n From Finder, double-click
[Application] =) [Olympus
Sonority] =) [Olympus Sonority].

When starting up for the first time,the
serial number registration dialog box
will appear.

Enter the Serial Number.

For the product serial number, refer
to the serial number on the separate
sheet.

The information display area will
appear if the serial number is correct.

+ You cannot run more than one “Olympus Sonority” program or multiple copies of the same

program simultaneously.

« When other applications such as DSS Player, etc. are opened, close these applications first

before starting up the “Olympus Sonority”.

Kyriouos sndwi|g buiuuny
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Window names (Olympus Sonority)

Olympus Sonority browse screen

This is the main screen of the “Olympus Sonority” (The display screen is the display screen in

Windows).
@-\_ ® Olympus Sonority.
o St Viw Baroak. Toob Devca” Voce Reropen Hob
=
@ -
foYu « » 'mim >

4 T Browser | i Edtor
=  Dlympus Sonority ' Flename
' Recording Foider

008
§EE

= (23 podcast Tray
(& charrel Guide
£ podcast

L owsyreay

Totalof 0 fles

(@ Menu Bar

The OS standard menu bar.

(2 Tool Bar

Tool Bar to be used in the Browse Screen
will be displayed.

(3 Playback Control Bar

Used to play selected files in the File
Display Area.

(@) Main Tree View

Files downloaded from the recorder, files
recorded in the “Olympus Sonority”, etc.,
and folders containing voice/music files
managed by the PC's “Olympus Sonority”
will be displayed.

(® Device Tree View

Folders in the connected device will be
displayed.

(® File List Display Area

Detailed information of the folders
selected in the Main Treeview or Device
Treeview and all voice files in the
recorder will be displayed.

The Information Display Area (Initial
Setting) will be displayed when the
“Olympus Sonority” is started up, and
the basic information of the “Olympus
Sonority” can be displayed, updated and
upgraded (= P.136).



Window names (Olympus Sonority)

Olympus Sonority information display area

“Olympus Sonority” Information Display Area Update of the “Olympus Sonority” and
confirmation and update of the firmware of the connected recorder can be carried out.
Upgrade to the “Olympus Sonority Plus” and registration of Podcast programs can also be

carried out.

When the “Olympus
Sonority” is started up for
the first time, Information
Display Area will be
displayed in the File List
Display Area in the Browse
Screen.

(@) Audio File List
Selects Folder A in the Main Treeview
and displays the File List Display Area.

(2) Opening the Program Guide
Displays the latest information on the
Podcast Program Guide.

(@ Updating latest information
Updates the latest information from
Olympus.

(@ Viewing updated information
Confirms the updated information of the
“Olympus Sonority” and recorder that is
connected.

() Registering the Upgrade Key
Number
Registers the purchased upgrade key
number.

(® Upgrade
Select the upgrade you want to
purchase. When upgrade is completed,
the button will be replaced by the
upgrade key.

@ Display/Hide
Select to show or hide the Information
Display Area the next time “Olympus
Sonority” is started. When hide is
selected, the File List Display Area (=
P.120) will be shown.

(A3110u0g sndwif}0) soweu mopuip E
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Download voice files from the recorder

There are 3 download options to transfer voice files from the recorder to the PC:

+ Download Selected Files
+ Download Folders
+ Download All

The following is an explanation of [Download Selected Files]. For explanations of
[Download Folders] and [Download All], refer to Online Help (= P. 118).

Download Selected Files

I select the folder.

« From the Device Tree View, select
the folder that contains the voice
file you would like to download. The
illustration shows that [Folder A] has
been selected.

Select the voice file.
« Select the voice file you want to
download from the File List Display
Area.
To select more than one file:
Windows:

Hold either the [Ctrl] or [Shift] key and
select files.

Macintosh:

Hold either the [Command] key and select
files.

= [=D Device Manager
=8 DM-5(DME)
o

6 Falder C
Wb Folder D
i Folder E
Erll Music
5 Podlcast
[ DaIsy

Total of 5 files

REC | eo—

el —] o o - — a
pEnonen @ ——s (@
| Filename Lengih Creation Date

—eEs =

B
—

7 (2] DM 100323-0057 wav 00:00:20 2010/03/23 1«
7 |2 DM4 100324-0058.wina 00:00:02 2010/03/24 9
[4]DM4 100324-0059.mp3 00:02:55 2010/03/24 1
4]DM4 100324-0060, rpa 00:03:24 2010/03/24 18
[4]%OC_000101-0001.mp3 00:00:00 2010/01/13 1t



Download voice files from the recorder

El pownload the voice file.

« From the [Device] Menu, select
[Download Selected Files] or click
[£7%] on the Tool Bar.

Download complete.

« Do not disconnect the USB cable
while the LED indicator light on the
recorder is flashing. Disconnecting
the USB cable when the LED indicator
light is flashing will result in data loss
or corruption (== P.112).

® Olympus Sonority,

Fis Bt View Playback oics Recognition  Help

El ‘i Download Folder & Crrl+
#5 Download Folder B Chile
&7 Download Folder €. Chri+t
&5 Downioad Folder D Ctrit
&2 Downinad Folder £ Cirlte
=
&

For

q ] Browser
= (3 Dlympus Sonority|
3 Recording Folder|
= &) Download Tray
 Folder &

Downloading

VOC_100215-0001.vma
DME50001. 9N A

[ ) [ cancel

Remaining 3373 K bytes

be destroyed.

files.

folder in the recorder.

NEVER disconnect the USB while the LED indicator light is flashing. If you do, the data will
Depending on the size of the voice file and your PC, it may take some time to download the

The downloaded files will be stored in the download tray folder that corresponds to the

(Example: A voice file downloaded from [Folder A] will be stored in download [Folder A]

on the Main Treeview.)

When the same file name already exists, the new file is saved with another file name

only when the contents are different. When the contents are the same, it will not be

downloaded.
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Play a voice file

[ Windows M Macintosh] el Y,
Fod W« B o

4 [E erowser Editar
= G Olympus Sonority

1Ll Recording Folder
Cllog a

I select the folder.
« Select the folder that contains the
voice file you would like to play.
=}

WOC_000101-0
WOC_000101-0
WOC_000101-0
WOC_100215-0
W
Wi
Wi

Select the voice file.

+ Select the file to playback from the
File List Display Area.

- Play the voice file. o onaico

_100215-0
_100215-0
100215-0

Podcaft Tray
[ DAIS Y Tray

LRI RN}

iy

) + Clickthe [ » ] (play) button of the
o Play Control Bar.

3

7 Other playback control such as Rewind,

= Fast Forward, Stop, Speed Control, Volume
o Control, Time Axis and Index Skip are

available from the Play Control Bar.
EN
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Using the waveform editing function
 Windows l Macintosh]

You can use the Waveform Editing Tab in the “Olympus Sonority” to easily process voice data.
In the Waveform Editing Mode, you can also delete unnecessary parts, paste and re-save the
data.

n From the Browse screen, select Click on any waveform display
the file you want to edit, select part.
[File] <) [Edit]. - Selected waveforms in the waveform
The waveform editing screen will display will become grey.
gli"s’:)?:;:gd the waveform will be Select [Paste] from the [Edit]
) Menu.
Drag and select the waveform The waveforms that were cut
you want to delete. previously will be inserted in the part
Selected parts will become grey in selected.
the waveform display. n Click the Write Track Zone [["55] m
Select [Cut] from the [Edit] Menu. - The Save dialog box will appear.
The selected waveforms will be
deleted.

Using the one-touch effect function
[ Windows W Wiacintosh

Using the one-touch effect function, you can easily apply special effects to the voice file.
Here we show you how to carry out noise reduction in a specified area.

uoI1dIUNy 133443 Yono3-auo 3y} buisp
Juo1puny buryipa wioyanem ay) buisg

n From the Browse screen, select Press the noise reduction
the file you want to edit, select adjustment button [g].
[File] =) [Edit]. - Noise will be removed from the
The waveform editing screen will selected part.
gf’p‘faragd the waveform will be Click the start location of the
Isplayed. selected partand pressthe[[ » ]
Drag and select the waveform button on the Playback Control
part you want to apply special Bar.

effects on. The part where noise has been
Selected parts will become grey in reduced will start to play.

the waveform display. EN
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Upload voice files to the recorder
| Windows M Macintosh]

“Olympus Sonority” has a feature to enable you to upload files from your PC to the recorder.
e TR s e R

4 =l Browser Editor
= (3 Olympus Sonority

{3 Recording Folder

oo

I select the folder.

« Select the folder that contains the
voice file to upload from the Main
Tree View. o

Select the voice file.
« Select the file you want to transmit
from the File List Display Area. &
Podcdet Tray
Select the folder to upload. s A

« From the [Device] menu select
[Upload Selected Files] or click the
Upload icon [*®]. Once the folder list
box where the file is to be uploaded
is displayed, select the folder from
which the file is to be uploaded.

Upload the voice file.
+ Click [OK] to upload the voice file to
the recorder.
Upload complete.

« Once the transmission screen closes
and the LED indicator light on the
recorder is OFF, upload is completed.

® Olympus Sonority.

Fle Edit View FPlayback ‘oice Recognition  Help

E % BB X wiload Folder & Crl+Alt+A
#5 Dowrload Foider B Ctr+Alt+8
#G Dowrload Folder C ClrHalt+C
0 Downioad Folder D Ctri+Alt+D
£ Dowrload Folder E ClrltAlE

%

< 0 Browser | Ecifpr
= (3 Olympus Sonority
4 Recording Folder

= &) pownioad Tray

TTT
]

% Dowrivad Al Ctrl+Shift+M

& upload Selected Fiks. Ctrlsshift+U

You can also transmit a file by selecting the
file you want to transmit from the File List
Display Area, and then drag and drop it in
the Device Treeview folder (move the mouse
while pressing the left mouse button, and
release the button at the destination).

13p10321 3Y3 03 s3]y 3310A peojdn !

=) Fulder
55 Folder 0
+ NEVER disconnect the USB while the LED o
indicator light is flashing. If you do, the £ Power of Love

data will be destroyed.
+ When the same file name already exists in
the folder on the recorder, the new file is
EN saved with another file name only when
the contents are different. If contents are
126 the same, it will not be uploaded.




About Podcast

Register a podcast program

You can either drag and drop the Podcast Program Icon to retrieve Podcast contents or
search and retrieve it by registering the content address.

This function is not supported in Macintosh. Use iTunes, etc. to retrieve Podcast contents.

n Start Olympus Sonority.

Open aweb browserand gotoa
Podcasting site.

Drag the Podcast registration
icon and drop it in the [Podcast]
folder in Olympus Sonority.

« Podcast registration icons differ
depending on Podcasting sites.
Please check each Podcasting site for
details.

Program registration will
complete.

« When a program is registered, a list of
broadcasting content provided by the
program will appear in the [Podcast]
folder’s list view. By default, the latest
content at the time of registration will
be automatically downloaded.

+ About the file format which can be played
back with the recorder, refer to P.48.

1
Drag and drop the

icon to the Podcast [OwSser Editor

registration ic

on. .
pus Sonority

(=]

=

® Olympus Sonority.

B

d W K[«
<[5 Browser | ) Edter |
= © olympus Sonority

Q Recoring Foker
= &3 Dowiosd Tray
5 Folder &
8 Folder
& Folder €
5 Folder 0

= (&) podkcast Tray
LJ Charrel Guide

T

= 1 Device Manager

i Recording Folder
Dowenload Tray

@8 Folder A

@8 Folder B

e Folder C

@5 Folder D

e Folder E
Podcast Tray

Fle Edt Vew Plajback Toos Devcs VoceRecogniton Hep

| staus ma Re\s

-’] P - Fuumqam 15A12/2n02n1nﬁ

1AM - Full Program
8] AM - Full rogram - 16/02/2010 2010)
] ChN News Updats
& avitows ThEE e,

[elelelelo]

N News Upe
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About Podcast

Update a program

By default, programs registered in “Olympus Sonority” will be automatically updated. To change
update intervals, go to [Tools] menu then [Options], and change them in the Options dialog’s
Podcast tab. Please see the Online Help for details (= P.118).

If you don’t want to update programs automatically, you can update the using the following
procedure.

Program registration, update and download functions are not available in Macintosh. Use
iTunes or other applications for these functions.

I select the [Podcast] folder. — T -

= @ olympus Sonority '
i Recording Folder
= &) Download Tray
8 Folder &
{8 Folder B
i€ Folder C
8 Folder D
2 Folder £
=12} Podcast Tray

Status Title
E PM - Full Program
PM - Full Program -
£ &M - Full Program

CNN News Update (:
CNN News Update (:
G Mews Undate
CNN Mews Update

Select a program you want to
update.

Olympus Sonority.

Select [Update Podcast] from the
[Tools] Menu or press the [£] in
the Tool Bar.

« Updating program starts.
Once the program has been updated
the new content will be displayed in
gray. The content displayed in gray
has not yet been downloaded onto a
computer.

Fle Edit View Playback |Tooks | Device Voice Recognition  Hely

EE = ogem
Select Speaker

Select Microphone Vol L mmmm

g ==

® =

OLE Settings
Pockast
| 7]
£4 options.. Ctrl+,
1[5 Browser Ecifor fm=

= (3 olympus Sonority 1 Stats |
U Recording Folder

5% Undate Podcast
Tevee

=] Download Tray %
Rt £ Restore fles
8 Folcer B
e Folder =
{5 Folcer D 28] i flews Update (¢
{2 Folder E N ewrs Update (¢
ws Update (;

&2 Podkcast Tray

{2 Channel Guide CHN flews Updats (¢
S r—

CHn fews Updats ¢



Download the content

About Podcast

By default, if new content is found when a program is updated, the latest content will be
automatically downloaded. This setting can be changed by selecting [Tools] then [Options]
and going to the Options dialog’s Podcast tab. Please see the Online Help for details (v P.118) .

If you want to download manually, the content can be downloaded with the procedure

described below.

Program registration, update and download functions are not available in Macintosh. Use

iTunes or other applications for these functions.

n Select the [Podcast] folder.

Click the [Download] button
of the content you want to
download.
« Content downloading will start.
The status is displayed by the
percentage while contents are being
downloaded.

Download will complete.

« Downloaded content can be played
and transferred to the recorder.

4 [ Browser | [ Editor
= (9 Dlympus Sonority. |
Q) Recording Folder
& & Download Tray
8 Folder A
B Folder B
8 Folder C

§5 Folder D
e Folder E

= [ Device Manager

Stats | Title

4% PM - Full Prograrm - 15/02... (
M - Full Prograrm (
B NN News Update

f Status Title

rity.

x
CMM MNews Update (2-15: [T]
CHM Mews Update (2-15-2... €

joxk Tock Davca Voks Recogribon Heb

B PM - Full Fragram

PM - Full Pragram - 15/02/20...
= &M - Full Frogram

AM - Full Prograrm - 16/02/2010
= CHM News Update

CMM Mews Update (2-16-2010...

o) k|« [ e § e

< orowser | bt |

ey

T Rebasedata | Lo
1 7M - ullFrogram ©a00215

o8 P - Full Program - 15/02/20... 201082715 00
1 4 - Full Frogram 201002715

8 M - Full Program - 16/02/2010 20100215 00:2

1 O s Updt

ff CNews Update (2-16-2010, me
e

1se2pod Inoqy
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Transfer content to the recorder

About Podcast

In the default setting, the content automatically transferred into the [Podcast] folder on
the recorder when the recorder connects to a computer. This setting can be changed by
selecting [Tools] under [Options], and by selecting the [Podcast] tab displayed on the

Option dialog box. Please see the Online Help (= P.118) for details.

If you want to transfer content manually, follow the procedure below.
Podcast contents registered in iTunes, etc. can be transmitted to this recorder by dragging
and dropping itin the recorder’s [Podcast] folder.

Il select the [Podcast] folder.

Select the content you want
to transfer, and drag it to the
[Podcast] folder of the recorder
and drop it.
- Content transfer will start.
A progress window will appear during
transfer.

Transfer will complete.
+ Content transferred to the recorder
will have an icon [d] indicating a
completed transfer.

< Browser Edtor
=  Olympus Sonority
U Recording Folder
= (&) Download Tray
A Folder A
8 Folder B
3 Folder ¢
6 Folder D
e Folder E
& (2 Podcast Tray

5 Folder D
&2 Folder E

5) Podcast

! stats

Tite
P - Full Program
8 PM - Full Program - 15/02/20.
1 AM- Full Program |
8 AM - Full Program - 16/02/201

] CN News Update
] NN News Update (2-16-2010,
8| CNN News Update (2-16-2010,
6] CNN News Update (2-15-2010,
News Upd

Copying....

(a7

ONN News Update 0-15-2010 8 PM EST) 1 me3
From ‘NN News Update’ 10 'ONN News Lpdate'

(

10 Seconds Remaining

» NEVER disconnect the USB while the LED
indicator light is flashing. If you do, the
data will be destroyed.

4[] Browser | Editor
= (3 Olympus Sonority
0 Recording Folder
= &l Download Tray
8 Folder &
8 Folder B
8 Folder C
B Folder D
2 Folder E
= () Podcast Tray
(2 Chamnel Guide

[ DaISY Tray

= ) Device Manager

! staus

Tite
P - Full Program |
] PM - Full Program - 15/52/20,

B #M-Full Program
8 AM - Full Program - 16/02/201

NN News Update
&8 CNN News Update (2-16-2010.
6] CNN News Update (2-16-2010,
&6 CNN News Update (2-15-2010.
6] NN News Update (2-15-2010.
10,




Program guide functions

About Podcast

OLYMPUS related podcast programs can be easily registered and new contents can be
automatically downloaded on the “Olympus Sonority”. New contents can also be redirected

to the recorder by just connecting to the PC.

Program guide functions are not available for Macintosh.

To register programs

I click (channel Guide] in the
online service of the Main Tree
View.

« Information of programs registered
online will be displayed.

Click the program you desire
from the program list.

«+ Detailed information on the program
will be displayed in the Program
Details View.

Click [Subscribe] to register on
the podcast.

« Once the program is registered, the
contents broadcast by the program
will be displayed in the List View of
the [Podcast] folder.

Under the initial settings, the latest
contents being broadcast will be
automatically downloaded during
registration.

4 [ Browser | i Edor

4 @ Browser Ec

=] G Olympus Sonority
8 Recaording Folder
= Dowenload Tray
s Folder A
@E Folder B
[@e Folder
@0 Folder D

=Qo
08 Recording Fotder
& oownioad Tray
& Folder &
& Fokir e
& ol ¢
& rolcer 0
2 ol €
& 63 Pockast Tray

) Podcast
R pasY Tray

ross Cultural Seminar
voicetrek.jp
Category: Education
Language: Englisn
wiebsite
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About DAISY (For DM-5)

What does DAISY stand for?

DAISY stands for Digital Accessible Information System. Originally intended as a replacement
for audio tapes for visually impaired people, the books and information are now used

by people with various reading disabilities. DAISY is a worldwide accessible information
system developed and maintained by the Daisy Consortium, an international collaborative
development organization.

What is multimedia DAISY?

While listening to audio via computer, it is possible to simultaneously view drawings and
pictures. Since the portion being read is highlighted, it is possible to know what section is
being read. Itis also possible to change the speed of the audio and jump to different pages.
There are children and students studying with multimedia DAISY as learning materials.

How do you play multimedia DAISY?

Afterinstalling the “Olympus Sonority” software supplied with this recorder onto a computer (==
P.115), select the [DAISY tray] folder from the browser window, and then press the play button to
experience multimedia DAISY. During playback, it is possible to skip text and headings, as well
as quickly jJump to a section by clicking it. If a bookmark is set in advance, it is also possible to
start playback from that position at any time. For more details, please see “Playing contents”
(s P.134).

Mt.Olympus- the mountain where gods and
goddesses live

Detailed information about DAISY

For more detailed information about DAISY, please visit the following web page.
Official web page of the Daisy Consortium.



Importing contents

About DAISY (For DM-5)

DAISY book content can be imported into “Olympus Sonority”. The content can be played
by selecting it from the [DAISY tray]. Import and playback are possible with Version 2.0/2.02

DAISY content.

I Place a DAISY file or folder with
DAISY files on the desktop of the
computer.

Start “Olympus Sonority”.

H From the [File] menu of “Olympus
Sonority”, select [Import], and
then [Import DAISY book].

A file dialog box is displayed.

Select the DAISY file to be

imported and then click [Open].

Import starts.
Imported files are displayed as a list.

(S-W@ 404) ASIva Inoqy E
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Playing contents

I Click [DAISY tray].

+ Alist of DAISY books registered in
“Olympus Sonority” is displayed.

From the list, click the title you
wish to play.
« Afileimport window is displayed.

From the playback control bar,

click [[ || 1 (Play) to play the
DAISY content.

« The DAISY content starts playing.

+ Usingthe[=4]or button,
you can skip to the previous or next
section.

« Clickthe [ ] button to display the
table of contents.

About DAISY (For DM-5)

20503720

D Device Manager

= otmpus sonority
Qi

i Fadern “Tre Lt Match G
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B Device Manager

Olympus Sonority. 2

Loading About OLYMPUS. ..

Cancel

® Otympus Sonority
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Transfer content to the recorder

n Connect the recorder to aPPC, and
start Olympus Sonority.
« Adevice tree is displayed in Device
Manager.
Select the content you want to
transfer.

« Select the file you want to download
from the File List Display Area.

To select more than one file:
Windows:

Hold either the [Ctrl] or [Shift] key and
select files.

Macintosh:

Hold either the [Command] key and select
files.

From the [Device] menuin
“Olympus Sonority”, select
[Upload DAISY book].

+ The transfer of content starts.
A progress window is displayed while
content is being transferred.

Transfer will complete.

+ Content transferred to the recorder
will have an icon [F]] indicating a
completed transfer.

« Bookmarks for DAISY books set in
“Olympus Sonority” can also be used
on the recorder.

About DAISY (For DM-5)

® Olympus Sonority

Flo Et ven clabak Took Do heb
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=& Fres: 031224 00:26:08
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aud01 mp3

From 'abaut OLYMPUIS' ko "About OLYMPUS'

l 1

+ NEVER disconnect the USB while the LED indicator light is flashing. If you do, the data will

be destroyed.
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Upgrade function
 Windows l Macintosh]

The “Olympus Sonority” can be upgraded
to the Plus Version (Optional) to expand and
improve its functions. In addition, in the
“Olympus Sonority Plus”, you can purchase
a Music Editing Plug-in to enjoy high-quality
effect editing. To add a Music Editing Plug-
in, you will need to upgrade the “Olympus
Sonority Plus”.

Purchase and upgrade

To purchase “Olympus Sonority Plus” and to
upgrade from “Olympus Sonority” is shown
in the following procedures.

m n Start the “Olympus Sonority”.

uoipuny apesbdpn

EN
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Please see = P.119 for the starting
method.

Select [Purchase Olympus
Sonority Plus] in the [Help] Menu
or click the [, ] button in the Tool
Bar.

The web browser will start and

the purchase site of the “Olympus
Sonority Plus” will be displayed.
Please operate according to guidance
on the screen. When the purchase
procedure is completed, the Upgrade
Key will be issued by mail.

Select [Upgrade to Olympus
Sonority Plus] from the [Help]
menu.

The [Upgrade to Olympus Sonority
Plus] dialog will be displayed.

n In the [Upgrade to Olympus
Sonority Plus] dialog, enter the
Upgrade Key of your purchase,
and click the [0K] button.

When starting the application next

time, “Olympus Sonority” will be
upgraded to “Olympus Sonority Plus”.

Upgrading to Olympus Sonority Plus

Click the root of the Main Treeview,
[Olympus Sonority], in the Browse Screen
to display the Information Screen. You can
confirm that the upgrade key is registered.
In addition, when [Version Information]
in the [Help] Menu is selected, the upgrade
key registered in “Olympus Sonority Plus”
will be displayed. The Music Editing Plug-in
includes more than 20 types of effect
functions and spectrum analyzer functions.
For details, please refer to the Online Help
(v P. 118).

« To purchase the Upgrade Key, it requires
an environment where the Internet can be
utilized.

« Please see the details in the website
regarding the purchase of the Upgrade
Key.




Functions available in the Olympus Sonority Plus

Besides the usual functions, the “Olympus Sonority Plus” also includes various functions to
edit music files. For information on operating procedures and detailed settings, please refer
to the Online Help (= P.118).

MP3 editing

MP3 file and tag editing and writing function.

Creating music (D

Function to create music CD from voice files registered in the CD writable folder.

Recorder menu setting

Function for settings in this recorder (detailed settings such as recording mode, alarm
setting, timer recording, etc.).

Functions available with the music editing plug-in

By purchasing a music editing plug-in, you can add high-quality functions to expand the
music editing range in the “Olympus Sonority Plus”. For detailed purchasing method and
operating procedures, please refer to the Online Help (= P.118).

You can use more than 20 high-quality effect functions to edit your music files.

Spectrum analyzer

Displays in the Waveform Display Screen the waveform distribution of an voice file being
played in the real time.

Besides unrestricted track editing

It also removes the restriction on the number of tracks that can be edited.

wi-6npd Huyipa disnw 3y Y3im 3jqejieae suoiduny
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About Windows Media Player

Using Windows Media Player

Music files that have been imported to your
computer from music CDs and acquired over
the Internet can be transferred to and played
back with this recorder. It supports WAV, MP3,
and WMA format music files.

By using Windows Media Player, music files
from music CDs can be converted (ripped
(v P.139).

Download Audible content available from the
Audible web site for a fee to a computer.

Window names

Windows Media Player 12 Windows Media Player 11

r'®

R Ir I8

(1) Features taskbar (1) Features taskbar
(@ seek slider (2 Sseek slider

(3@ Shuffle button (3 Shuffle button
(@ Repeat button (@ Repeat button
(B Stop button (® Stop button

(6 Previous button (6 Previous button
@ Play button (@ Play button

Next button Next button

(9 Mute button (9 Mute button

9 Volume slider 19 Volume slider



Copying music from (D

Windows Media Player 12

Il insert CD into the CD-ROM drive,
and start Windows Media Player.

From the Features taskbar, click
[Rip CD] menu.
- If Internet connectivity is available,
CD information is searched.
Put a check mark on the music
file that you want to copy.

Click [Start Rip].

Files copied to a PCare stored in
WMA format. Music files copied are
categorized by artist, album, genre,
etc. and added to the play list.

Using Windows Media Player

19£elq eipay smopuiy buisn H
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Using Windows Media Player

Windows Media Player 11

Il insert CD into the CD-ROM drive,
and start Windows Media Player.

From the Features taskbar, click
[Rip] menu.
After clicking [Rip] menu, click [View
Album Info] for Windows Media
Player 10 as necessary.
If Internet connectivity is available,
CD information is searched.

Put a check mark on the music
file that you want to copy.

n Click [Start Rip].

For Windows Media Player 10 Click
[Rip Music].

Files copied to a PCare stored in
WMA format. Music files copied are
categorized by artist, album, genre,
etc. and added to the play list.




Transferring music file to the recorder

You can transfer the music files saved in your PC to this recorder. For how to copy the music

Using Windows Media Player

files from the CD to your PC, please see “Copying music from CD” (== P.139).

Windows Media Player 12

n Connect the recorder to a PC, and
start Windows Media Player.

From the [Organize] menu, click
[Options]. At the Options dialog
box, click the [Devices] tab.

From the Devices list, select
[DM_5(or 3)], and then click
[Properties].

+ Click on the [Create folder hierarchy
on device] to check.
If you uncheck and syncronize the
file, it will be transfered under the
folder [Home], and the file will not be
indicated. *1 *2

+ The folder with artist name or album
name is automatically created. This
will make you find the file you want to
listen to more easily.

*1If [Create folder hierarchy on
device] is checked by default, click
to uncheck the box once, and click it
again to check.

*2 After the synchronous transfer to the
recorder, a file named “WMPInfo.xml”
is created. If you delete this file, the *1
may need to be set again.

Options [
Ubery_ | Pugins |_Py dy | DVD | Metwork
Plyer | RpMusic [ Devees ) Bum Pefomance

|ﬁ Specify settings for CDs, DVIs, displays, speakers, and portable
& devices.

Deyices

&% DVD/CDRW Drive (6:)
| K pisplay

'&ﬁﬁ

Refresh I Properties l

DM_sProperties =

Sme | Quality

)Q Set sync options for this device.

Device name:

Sync settings
7] Create folder hierarchy on device

Start sync when device connects
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Using Windows Media Player

n Select the desired category from
[Library] on the left, and select
music files or albums to transfer
to the recorder, and Drag & Drop
them in [Synclist] on the right.

Click [Start sync].
The file is transferred to the recorder.

+ Refer to the online help of Windows Media Player for details.

Windows Media Player 11

n Connect the recorder to aPC, and
start Windows Media Player.

From the Features taskbar, click
[Sync].

Click [Sync] menu again to select
[DVR] =) [Advanced Options] =)
[Set Up Sync], and set as follows.

Click on the [Create folder hierarchy
on device] to check.

If you uncheck and syncronize the
file, it will be transfered under the
folder [Home], and the file will not be
indicated. *1 *2

The folder with artist name or album
name is automatically created. This
will make you find the file you want to
listen to more easily.

19fe|q e1payy smopuiy buisp H
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Using Windows Media Player

*1If [Create folder hierarchy on DVR Properties =]
device] is checked by default, click S [ Gusiy
to uncheck the box once, and click it
again to check.

*2 After the synchronous transfer to the
recorder, a file named “WMPInfo.xml” J
is created. If you delete this file, the *1 S‘;::'Zf;w ey oo
may need to be set again.

ek syne options for this device,
> yne opt

Device name:

0k [ Corcal [ Heo ]

n Select the desired category from
[Library] on the left, and select
music files or albums to transfer
to the recorder, and Drag & Drop
them in [Sync List] on the right.

Click [Start Sync].
« Thefileis transferred to the recorder.

13fejd eipay smopuipy buisn H

+ Refer to the online help of Windows Media Player for details.
« To transfer the files by using Windows Media Player 9 or 10, check the Olympus website.
« If the music files are transferred to the recorder until it reaches to the maximum memory,
the message [Can’t make the system file. Connect to PC and delete unnecessary file]
may appear on this recorder’s display. In such a case, erase the files to make free space
(hundreds of KB to dozens of MB depending on the music file sizes) for the management
file (The more capacity for the management file will be necessary as the number of the EN
music files increases).
143



Copying voice file to the (D

Using Windows Media Player

You can transfer the voice files in the recorder to your PC and copy them to CD. For how to
copy the voice files from the recorder to your PC, please see “Download voice files from the

recorder” (v P.122).

Windows Media Player 12

I insert the blank CD-R/RW into
the CD-R/RW drive, and start
Windows Media Player.

From the Features taskbar, click
the [Burn] menu.

Select the desired category from
[Library] on the left, and select
voice files or albums to copy to
the CD-R/RW, and Drag & Drop
them in [Burn list] on the right.

n Click the [Burn] tab, and select
[Data CD or DVD] or [Audio CD].

When [Audio CD] is selected:
A file is converted and copied in
CDin order to play it by the audio
equipment which can play CD-R/RW.
When [Data CD or DVD] is selected:
Copying files with the format to be
recorded.

Click [Start burn].

19fe|q e1payy smopuiy buisp H
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Using Windows Media Player

Windows Media Player 11

n Insert the blank CD-R/RW into
the CD-R/RW drive, and start
Windows Media Player.

From the Features taskbar, click
the [Burn] menu.

Select the desired category from
[Library] on the left, and select
voice files or albums to copy to
the CD-R/RW, and Drag & Drop
them in [Burn List] on the right.

Click the [Burn] menu again, and
select [Audio CD] or [Data CD].

When [Audio CD] is selected:
A file is converted and copied in
music CD in order to play it by the
audio equipment which can play
CD-R/RW.

When [Data (D] is selected:
Copying files with the format to be
recorded.

Click [Start Burn].

« Refer to the online help of Windows Media Player for details.
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Using Windows Media Player

Creating a playlist (For DM-5)

You can create playlists using Windows Media Player. If you save the playlist to the [Music]
folder on this recorder, you can play songs in the desired order.

Windows Media Player 12

n Connect the recorder to a PC, and
start Windows Media Player.
If the player is in Now Playing mode,
click [Go to Library] (Hl)on the
upper right corner of the window. P,
14 ’E‘ L B IR
Click the [Play] tab to open the
n list window.
« Ifitis necessary to delete list window
- content before creating a playlist,
£ click [Clear list] from the [ » ] icon.
(-]
=
3
o
[}
]
=
m
2
o
=2
] - . .
[ From the music titles displayed in
the library window, click the title
you wish to add to the playlist.
Next, drag the title to the list
window on the right side of the
window.
EN
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n In the list window, arrange the
titles in the order you want to.

From the top of the list window,
clickthe[Listoptions] ([©]* ) button.
From the menuthatdisplays, select
[Save list as].

A At the [Save As] display, enter
a file name and then select the
[MUSIC] folder of the recorder as
[Destination]. Click [Save].

Clickthe [Sync] tab.Drag the saved
playlist to the synchronization list
window on the right side of the
window.

ﬂ Click [Start sync].

Using Windows Media Player

popcasT |
RecoRDER
Text

W Neork
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Using Windows Media Player

Windows Media Player 11

n Connect the recorder to a PC, and
start Windows Media Player.

While the library window
displayed, click [Library] and
then [Create playlist].

From the music titles displayed in
the library window, click the title
you wish to add to the playlist.
Next, drag the title to the list
window on theright side of the
window.

19fe|q e1payy smopuiy buisp H

P click [Untitled playlist]. From the
menu that displays, select [Save
Playlist As].
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At the [Save As] display, enter
a file name and then select the
[MUSIC] folder of the recorder as
[Destination]. Click [Save].

A clickthe [Synd] tab. Drag the saved
playlist to the synchronization list
window on the right side of the
window.

Click [Start Synd].

Using Windows Media Player

Save As Px
Savein | ) MUSIC 3 o2 p@E
(Dinewvear
My Recent
Docunents
'
Desktop
My Documents
My Computer
Fie pame: Playictwpl v Save
My Network | Save asype: [ Windows Media Paict (v v = I

+ Songs in the built-in memory of the recorder and songs on external memory cannot be

mixed in the same playlist.

« If the music files on the PC are not arranged as shown on P.154 (the default ripping
configuration), it may not be possible to play the playlist correctly.
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About iTunes

Using iTunes

Music files that have been imported to your computer from music CDs and acquired over the
Internet can be transferred to and played back with this recorder.
By using iTunes, music files from music CDs can be converted (ripped) (s== P.151).

Window names

s File Edit Controls View Store Advanced Window Helpl

TTunes

2 ( )
@ OO )Gl e =—c s EL= =) (o
s ﬁ
e WAl Name Time Arist Aoum e
G D e

f
S 2 @ v0C 0001010011 70
[z 3 @vocomioronz 144
& 1vshows 4 @v0C_0001030013 002

s

s

7

@ podcasts  ¥0C_000103.0014 014
0 Radio & ¥0C_000103.0015 052

@ voC_000103.0016 o8

STORE

sl

saunpi buisp H

iTunes Store

(1) Features taskbar (5) Shuffle button
(@ Rewind button/ (® Repeat button
Playback, Pause button/ (@ Display change button
Fast Forward button Disc create button
® Volumesslide (@ Genius button
EN @ Playlist addition button Genius side button
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Copying music from (D

n Insert the CD into the CD-ROM
drive, and startiTunes.

Click [iTunes] =) [Preferences].
Click [Advanced] tag.

n Click [Importing] to set the file
format and bit rate for copying
music files to your PC, and click
[OK].
This recorder is compatible with
music files in the MP3 and WAV
formats (= P.48).

[Import Using]:
Set the file format for copying music
file from a CD. Please select [MP3] or
[WAV].

[Setting]:
Set the bit rate for copying music file
from a CD. You can select a bit rate
between [128], [160] and [192].

Put a check mark on the music
files that you want to copy.

A click [import cD].

Using iTunes
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Using iTunes

Transferring music file to the recorder

You can transfer the music files saved in your PC to this recorder. For how to copy the music
files from the CD to your PC, please see “Copying music from CD” (= P.151).

Bl it ool Vi S A, Vo,V

[l Connect the recorder to a PC, and
start iTunes.

Select the play list to be
transferred to the recorder, and
put the check marks on the music
files that you want to transfer.

The order of music pieces can be
changed by Drag & Drop of the music
file in the play list displayed.

Double-click the corresponding
drive with the recorder, and open
[Music] folder.

When you connect the recorder to a
Mac OS, it will be recognized by the
drive name of the product name on
the desktop.

Copy to [Music] folder of the recorder
when transferring the music file.

Select the desired files, and Drag
& Drop them to [Music] folder.

Drag & Drop
files here

saunp1 buisp !

1
1
1
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+ Music files in the AAC format purchased from a music distribution service such as the
iTunes Store cannot be played by this recorder.
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Using iTunes

Copying voice file to the (D

You can transfer the voice files in the recorder to your PC and copy them to CD. For how to
copy the voice files from the recorder to your PC, please see “Download voice files from the
recorder” (v P.122).

Il insert the CD-R/RW into the CD-
R/RW drive, and start iTunes.

Select the desired playlist, and
put a check mark on the voice
files to copy to the CD-R/RW.

Click [Burn Disc]

iTunes Store

=== GCEy=

To set the CD format for copying
voice files to CD-R/RW, and click

[0K].

When [Audio CD] is selected:
A file is converted and copied in
music CD in order to play it by the
audio equipment which can play
CD-R/RW.

When [MP3 (D] is selected:
Copying in MP3 format.

When [Data CD or DVD] is selected:
Copying files with the format to be NS

recorded. 5 @
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Other features

Playing songs in a particular order

Lists created and
playlist file to the
order.

saved as a file on a computer are called playlist files. By transferring a
[Music] folder of this recorder, it is possible to play songs in a particular

- With playlists, it is possible to play multiple songs on this recorder in a freely determined

order.

« This recorder supports .m3u playlist files.
Creating a playlist

This section explains the procedure to create, transfer, and play a playlist. This explanation
will use the files and folders shown in the [Music] folder below and play the files in order

from @) to ®.

First layer Second layer Third layer

—m— . BESTSONG-01.wma,
! BESTSONG-02.wma =1

! BESTSONG-03.wma —@

1 1
—m \ HITSONG-01.mp3 ——3)
-E HITSONG-02.mp3 —®
» HITSONG-03.mp3

1
! |
1 1
' LIVE-01.mp3 ———@)
* LIVE-02.mp3 ———@
« LIVE-03.mp3

1
Albumo04 ! NEWSONG-01 .wma+@

. NEWSONG-OZ.wma-:-@
. NEWSONG-03.wma !

Artist 02



Playing songs in a particular order

n Click the [Start] button, select
[Programs] =) [Accessories] =)
[Notepad].

« Notepad opens.

Enter the names of files in the
[Music] folder in the order you
want them to be played.

« Thefile names in the playlist are
entered in the following manner:
Drive letter (F:):\Folder name\File
name.

« The easiest way to ensure that the
file names are entered correctly is to
open the properties for the file you
want to enter into the play list, copy
the file name, and then paste that
name into the playlist being created
in Notepad.

« Ifthere are too many characters,
playback may not be possible. As a
guide, try to keep entries on a single
line to within 256 characters.

n Instead of the drive letter “F”,
any single half-width character
can be used.

A maximum of 999 songs can be
entered into a single play list.

From the [File] menu, select [Save
As]. Enter a file name followed by
the extension “.m3u” and then
save the file.

B Notepad

Ele Edt Format View Help

FA\MUSICNARTISTO1VAL BUMOL\BESTSONG-02. wma
Fi \MUSIC\ARTISTOl\ALEUMOl\BESTSQNG 03 wma
F \MUSICHVARTI ST 027\ AL BLMO4 \NEWSONG—

F i \MUSICNARTI STOLN\ALBLMOZ\LTVE-02 . p

£ \MUSICW\ARTISTOL1\ALGLMOZ \HITSONG-01 . mp3
F: \MUSIC\ARTISTOZ\ALEUMOA\NEWSONG 01 itz
FAMUSICRARTIST =01,

F: )MUSIC\ARTISTOi\ALEuMOZ\rITSONG 5 mp3

Folder name File name
When there are layers of
folders, use the “\" mark
to indicate the layers
when entering informa-
tion.
[ save 1s (@3]
Savein: [(@ Desktop ERX:
(E3my Documents:
3 My Computer
MyRecent | “2My Network Places
Documents
Desktop.
D
s e
Q@) Pl Pl nzu —_—
MyNswok | Swesupe  [MFes
Encoting NSt v
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Playing songs in a particular order

n Drag the saved playlist file to the
[Music] folder of the recorder to
transfer it to the recorder.

Transfer the playlist file to the top
level (first layer) of the [Music] folder.
For more details about file transfers,
please see “Transferring music file
to the recorder” (v= P.141).

+ For more details about playing
transferred playlists, please see “File
search” (= P.53)

« Playing files in a specified order using playlists is limited to files in the [Music] folder (for
music playback).



About Audio Books
ED D

Audio Books are books that can be listened to. Digital audiobooks can be played anytime and
anywhere on players such as this recorder. Audio Books can be enjoyed in various ways. For
example, they can be listened to while moving by train, doing housework and jogging.

Transfer content to the recorder

[l Connecting the recorder to your P o y——— -
PC (= P.111). [-F;\d;rskt
Select the content you want E{— files here
to transfer, and drag it to the = 'QZ?ZE.“;;V .
[AUDIOBOOK] folder of the o Local Dk ()

recorder and drop it with
Explorer or Finder.

2 DVD-RW Drive (D)
5 e

The file is transferred to the recorder. o
12 MAGE
Disconnect the USB cable S e
and select [Audio Book] from & rECORDER
[Audiobooks] in the menu setting [R5
“## Removable Disk (F:)
screen. @ Contral Panel

Transferred file list will appear.

» NEVER disconnect the USB while the LED indicator light is flashing. If you do, the data will
be destroyed.

+ Audiobooks using the Digital Rights Management system (DRM) of the Microsoft
Corporation are not supported.

« This recorder can play files in MP3 and WMA formats.

s)00g o1pny 3noqy H

EN
157



(S-W@ 104) ypaads 3xa) Inoqy !

EN
158

About Text Speech (For DM-5)
D D

If a text file is transferred to this recorder and played, the text file can be read aloud. This
recorder can read aloud text created in various situations and can be used to confirm or review
audio content.

Transfer text file to the recorder

n Connecting the recorder to your adbess [ e
PC (*= P.112). Folders
[} Deskrop
Select the content you want to (£ My Documents

transfer, and drag it to the [TEXT] & 3y Conputer

H 3% Floppy (A1)

folder of the recorder and drop it < Local Disk (C:)
with Explorer or Finder. <5 DVD-RIN Drive (D) Drag &Drop
= %o Removable Disk (E:) files here
- Thefileis transferred to the recorder. [ AUDTOBOOK
. 1) DarsY
Disconnect the USB cable 5 hace
and select [Text Speech] from m rusc

[Audiobooks] in the menu setting o
screen.

Transferred file list will appear. [ control Panel

» NEVER disconnect the USB while the LED indicator light is flashing. If you do, the data will
be destroyed.
« This recorder can play file format, which consists of only character data text file (. txt) only.



Loading Audible content
D

Use the AudibleManager to load Audible content onto the recorder.
Playback, management, and transfer of Audible content to the recorder can be done using

the AudibleManager.
Installing AudibleManager

When AudibleManager is not installed on a computer, install the AudibleManager according

to the procedure described below.

n Access one of Audible web
sites from the web browser and
download the AudibleManager.
http://www.audible.com/ (United States)
http://www.audible.co.uk
(United Kingdom)
http://www.audible.fr (France)
http://www.audible.de (Germany)

Start up the downloaded
executable file.
+ The AudibleManager Setup screen
will be displayed. Select the name of
the device in use (OLYMPUS DM-5/3)
and click the [Install] button.

When the [AudibleManager
License Agreement] is displayed,
click the [l Accept] button.

Installation starts.

«  Wait until process has been
completed. Once the installation has
been completed AudibleManager
starts up automatically.

This program will nstall Aucdiblebansger, software that makes
it e3sy 1o dowrioad, orgarize, and fsten'to sudiofrom

Yo wil be ready ta stat listering in under 10 minutes.

Mobie D

1fyou akeady own an AudbleReady mobile device, please
select i fram the choices below:

(™ OIS DV 5T )

estination

Setup wil nstll Auciblebansge i the follwing folder

C\Progiam FlestAudible
Browse.

LICENSE AGREEMENT ~

This is 3 legal aeement *gresment”) between you the parly

Al
LEGALLY BOUND BY THEM. IF YOU DO NOT AGREE T0 TH
TERMS DF THIS AGREEMENT, YOU MAY NDT INSTALL DR USE
THE SOFTWARE.

L "Software'

documentaiion, and any patches, s, updates, upgrades, and

. and

ay cambinalion of the faregaing.

1. GRANT OF SOFTWARE LICENSE; SCOPE OF USE. Sublsct o the

Cance

juajuod 3jqipny buipeoq H
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Loading Audible content

Adding device to AudibleManager

If AudibleManager has already been installed, add a device in order to handle the recorder in
the AudibleManager. Follow the procedure described below.

n Select [Add New Device] in the

[Devices] menu.

Ctried,

My Hbra e Mobie Device CirkeShifteD

When the d|a|°g box disp|ays’

1

verify the internet connection (&) R
and click the [Yes] button.

When the dialog box is displayed,
check the name of the device in
use (DM-5/3) and click the [0K]

button.

Installation starts. ‘Mobile Devises
Wait until the process has been %2:1:35 e
completed. Once the installation has (7] Ho Device
been completed, AudibleManager
restarts.

Verify that the device in use has been
added to the [Mobile Devices] menu.

Purchasing Audible content

Audible content can be purchased from the Audible web site. Access to the Audible web

site using web browser and download the content by following the purchase procedures
described on the web site.

With the existing setting, content downloads to the Library folder in the AudibleManager.
When download has been completed, the AudibleManager starts up and purchased content
displays on the contents list in the Library.



Transferring Audible content

Audible content can be transferred into the [Audible] folder on the recorder by following the

procedure described below.

n Connect therecorder toa
computer.

Select [Library] in the [Audible
Folders] tree listing.
« Alist of content stored in the
[Library] displays on the right side.
Select the content to be
transferred to the recorder and
click the [Add to Device] button.

n When the [Activate Your Device]
entry screen is displayed, enter
the user name and password for
Audible and click the [0K] button.

The transfer begins.

« Wait until the transfer of the content
has been completed. When it has
been completed, the transferred
content is displayed in the contents
listing of the device. Also, the
transferred content is displayed in the
Library.

Activate Your Device

=
username and password, then press 'K buttan,

Userfame 7P
Password

Transfeiting Program
“Bpil 16, 2010: L Show'!

I Abort Transfer I—

for each content file in the Audible folder.

When a content file is transferred to the recorder, a [.pos] file will be automatically created

When the [*.pos] file is deleted, using Explorer, the stored Playback Position will be deleted.

The next time the file is selected, playback starts from the beginning of the file.

to playback the Audible content.

When a content file is transferred to the recorder, a system file will be created as a hidden
file inside the Audible folder. When this file is deleted using Explorer, it is no longer possible

Juajuod 3|qipny buniaysues) H
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Enjoy Audible content with the recorder

Audible content that has been transferred into the [Audible] folder on the recorder from
a computer can be enjoyed with an exclusive mode optimally suited for the operation of
Audible content.

Audible mode

When you select the [Audible] folder in the [Audiobooks] folder, the recorder automatically
switches to the Audible mode. The Audible mode is an exclusive mode for enjoying Audible
content (modes 3, and 4 formats*) transferred from a computer. The operating method for
Audible mode differs from when other folders on the recorder are selected (Normal mode).
Please see the “Operating recorder in Audible mode” (== P.164) for details.

File Display screen in Audible mode

In the Audible mode, play mode becomes the file setting
regardless of the menu settings and the recorder stops after
playing back one file. In addition, icons (&3], ) which
indicate Audible files are also displayed on the File display
screen.

(@ Audible file indicator

TNBE WENU

Re-playable Audible files

Files of modes 3 and 4 formats can be played back in the Audible mode. Only those Audible
files that have an [.aa] extension are displayed in the Audible mode (in the Audible folder on
the recorder).

Re-playable Audible files formats *

Mode Codec
3(c=) ACELP (16kbps)
4(cmn) MP3 (32kbps)




Enjoy Audible content with the recorder

Playback position and section

In the Audible mode, the starting position can be moved easily by referring to the Playback
Position which is the positional information stored from previous stops for each file, and by
referring to “Section” where the content distributor has preset the position.

Playback position

The Playback Position (positional information) is stored in the [.pos] file, which is created
automatically by the recorder for each Audible content file ([.aa] file).

The Playback Position is initially located at the beginning of the file, and the stop position will
be updated by playback or the use of S. Play (slow playback)/F. Play (fast playback).

Press the PP or <4 button to move the stop position while the recorder is stopped. The
Playback Position will not be updated.

Section

Up to a maximum 100 divisions (chapters of a story or segments of news) are set arbitrarily for
each file by the distributor of the content.

+ When a content file is transferred to the recorder, a [.pos] file will be automatically created
for each content file in the Audible folder.

You can not set the Index marks in the Audible mode.

When the [*.pos] file is deleted, using Explorer, the stored Playback Position will be deleted.
The next time the file is selected, playback starts from the beginning of the file.

When a content file is transferred to the recorder, a system file will be created as a hidden
file inside the Audible folder. When this file is deleted using Explorer, it is no longer possible
to playback the Audible content.

H
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Enjoy Audible content with the recorder

Operating recorder in Audible mode

The operating method on the recorder is different in the Audible mode when the [Audible]
folder or Audible file is selected, then while in the Normal mode.

Press and hold the B® button while the
recorder is stopped.
= \When the button is released fast
forwarding stops. The Playback
Position is not updated. When the
» OK button is pressed playback
resumes from that position.

Press and hold the P®1 button while
playing afile.
= When you release the B¥ button
the recorder will resume normal
playback.

- If the starting position of a section (=
P.163) and the playback position are in the
middle of a file, the recorder stops at that
position.

+ When the PP button is held down while

the recorder is stopped, the recorder

moves to the end of the file and then
stops.

If the B button is still held down,

the recorder moves to the next file and

continues fast forwarding from the

beginning of the file. After fast forward
reaches the end of the last file, the
recorder stops at the beginning of the last
file.

When the PP button is held down

during playback and the end of the file

is reached, the recorder goes back to the

beginning of the file and stops.

Press and hold the ¢ button while the
recorder is stopped.
= When the button is released fast
rewinding stops. The Playback Position
is not updated. When the »OK button
is pressed playback resumes from that
position.

Press and hold the <€ button while playing
afile.
= When the button is released playback
resumes from that position.

If the starting position of a section (=
P.163) and the playback position are in the
middle of a file, the recorder stops at that
position.

« When the <€ button is held down while
the recorder is stopped, the recorder
returns to the beginning of the file and
then stops. If the <€ button is still held
down, the recorder moves back to the
end of the previous file and continues fast
rewinding.

When the € button is held down
during playback and the recorder reaches
the beginning of the file, the recorder
starts playback from the beginning of that
file.

If the < button is kept pressed while
the recorder is stopped at the start of

the top file, the recorder will fast rewind
starting from the end of the last file.



Enjoy Audible content with the recorder

File Skip and Section Skip

Press the PP button while the recorder is
stopped.
= The recorder skips to a playback
position or the starting position of a
section, whichever is closer in the file,
and stops.
After a stop position, if there is no
playback position, or a starting position
of a section, the recorder will skip to a
playback position in the next file and
stop.

Press the 4 button when the recorder has
stopped at the beginning of a file.
= The recorder skips to the Playback
Position of the previous file and then
stops.

Press the I« button if the recorder has not
stopped at the beginning of a file.
= The recorder skips to a playback
position or the starting position of a
section, whichever is closer in the file,
and stops.

Press the PP button during playback.

= The recorder skips three seconds
forward, or to the starting position of
the next section, whichever is closer,
and starts to playback the file. After
reaching the end of thefile the recorder
stops at the beginning of the file. The
Playback Position is updated to the
beginning position of the file at this
time.

Press the 4 button during playback.
= The recorder skips three seconds back,
ortothe starting position of the current
section, whichever is closer, and starts
to playback the file. When the recorder
reaches the beginning of a file the file
plays from the beginning.
+ The [Skip Space] (= P.73) setting is invalid
in the Audible mode.

1910334 3Y3 Y3IM Juajuo) a|qipny Aofuz H
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Using as external memory of the PC

In addition to its uses as an IC recorder and a music player, this recorder can also be used as
external memory for a computer by storing data from a computer and reading it back out.
With the recorder connected to your PC, you can download data from the memory to your PC
and upload data stored on your PC to the memory.

n Connecting the recorder to your n Connecting the recorder to your
PC (= P.111). PC (= P.111).

When you connect the recorder to a

Mac OS, it will be recognized by the

drive name of the product name on

Open the Explorer window.
Open the product name folder.

Wh My C ter] it the desktop.
en you open [My Computer], i .
will be recognized by the drive name Double-click the product name
of the product name. icon on the desktop.
A copy the data. Copy the data.
Disconnect the recorder from the ] Disconnect the recorder from the
PC (= P.112). PC (= P.112).

+ While transmitting data, [Busy] is displayed, and the LED indicator light flashes. NEVER
disconnect the USB while the LED indicator light is flashing. If you do, the data will be
destroyed.



Other information

Alarm message list

Message Meaning Explanation Action

Charge the battery.

If you run out of battery
[Battery Low] Low battery power. Battery power is getting | soon after the charge, the

low.

battery life has ended.
Replace with new battery
(s P.21).

[File Protected]

Erase-locked.

Tried to delete a locked file.

Unlock the file (= P.75).

[Cannot record in this
folder]

Not an audio-recording
folder.

Recording has been
attempted with a
[Music], [Podcast],
[Audiobooks](Daisy,
Audio Book, Text Speech,
Audible) folder.

Select a folder from
[Folder A] through to
[Folder E] and try record-
ing again (= P.32).

The file is full of index

Erase index marks that

[Index Full] Index full. marks (maximum of 16 are no longer required
marks). (e P.51).
[Folder Full] Folder full The folder is full of files Erase unnecessary files

(maximum of 999 files).

(v P.60).

[Memory Error]

Error in the memory.

Error in the memory.

This is a malfunction, so
go to the store where you
purchased the recorder or
an Olympus service station
for repair (1= P.174).

[Card Error]

Error in the memory.

microSD card is not
recognized correctly.

Remove the microSD card
then put it again (= P.30
to P.31).

[Licence Mismatch]

Illegally copied file.

The music files copied
illegally.

Erase the file (x= P.60).

[Memory Full]

Zero remaining memory.

No remaining memory.

Erase unnecessary files
(== P.60).

[No File]

No file.

No files were found in
the folder.

Select another folder
(s= P.53 to P.59).

[Format Error]

Formatting error.

There was an error while
formatting the recorder’s
memory.

Reformat the memory
(v P.94).

[Can’t make the
system file. Connect
to PCand delete
unnecessary file]

The management file
cannot be created.

The file for management
cannot be created due to
a shortage of capacity for
remaining memory.

Connect therecordertoa
computer and delete any
unnecessary files.

[Cannot play this file]

File which cannot be
played.

Incompatible format.

Please confirm the file
that can be played on this
recorder (== P.48).
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Alarm message list/Troubleshooting

Message

Meaning

Explanation

Action

[Please Select The
File]

Unselected File

File is not selected.

Please select a file then
carry out the operation
(e P.53 to P.59).

[Same folder. Can't be
moved(copied).]

File cannot be moved
(copied).

Attempting to move (copy)
into the same folder.

Please select another
folder.

[Same files. Can't be
moved(copied).]

File cannot be moved
(copied).

File in the destination
with the same name, or
file with DRM.

Please select another file.

[This file can't be
divided.]

File which cannot be split.

Attempting to splitafile
besides the PCM files
recorded in this recorder.

Please select another file.

Troubleshooting

Symptom Probable cause Action
The battery is not loaded properly. (Cnl;e;;f;]e direction of the battery.
Nothing appears on m——
the display Battery power is getting low. Charge the battery (s P.21 to P.25).
The power is off. Turn the power on (== P.26).
Battery power is getting low. Replace with new battery (= P.21 to P.25).
Won't start The power is off. Turn the power on (s P.26).

The recorder is in HOLD mode.

Release the recorder from HOLD (s P.27).

Unable to record

Low remaining memory.

Erase unnecessary files (== P.60).

The maximum number of files has
been reached.

Change to the another folder
(= P.32, P.38).

No playback tone
heard

The earphone is connected.

Unplug the earphones to use the
internal speaker.

The volume level is set to [00].

Adjust the volume level (== P.46).

Recording level too
low

The recording level has not been
adjusted.

Adjust the recording level and then try
recording once more (= P.67).

The microphone sensitivity is too low.

Set the microphone sensitivity to [High]
or [Middle] mode and try again (= P.67).

This could potentially be because
the output level for the connected
external devices are too low.

Adjust the output level for the
connected devices.




Troubleshooting

Symptom

Probable cause

Action

Voice files are not
recorded in stereo

The connected external microphone
is monaural.

When recording while an external
monaural microphone is connected,
sound will only be recorded by the
L-channel.

[Rec Mode] is set to a monaural
recording mode.

Set [Rec Mode] to the stereo
recording mode (= P.67).

Cannot find the
recorded Voice File

Wrong folder.

Switch to the correct folder
(= P.32, P.38).

Noise heard during
playback

The recorder was shaken during
recording.

The recorder was placed near a cell
phone or fluorescent lamp while
recording or during playback.

Move the recorder.

Unable to erase the
file

Thefile is locked.

Unlock the file (= P.75).

Thefile is read-only.

Unlock the file or cancel the read-only
setting of the file on the PC.

Unable to erase the
folder

There are files which cannot be
recognized with the recorder.

Connect the recorder to PC for erasing
files.

Noise is audible
through the recording
monitor

Acoustic feedback is occurring.

When the built-in speaker amps and the
like are connected there is a risk that
audio feedback will occur while record-
ing. Itis recommended that you use
earphones for the recording monitor.

Conduct adjustments like separating
the earphones from the microphone
further, do not point the microphone
at the earphones, lower the volume on
the recording monitor, and so on.

Unable to setindex
marks

The maximum number of marks has
been reached.

Erase unnecessary marks (s P.51).

The file is locked.

Unlock the file (= P.75).

The file is read-only.

Unlock the file or cancel the read-only
setting of the file on the PC.

Cannot charge

Contains battery other than the
specified battery.

Please insert the chargeable battery
provided.
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Accessories (optional)

Accessories exclusive to the Olympus IC recorder can be purchased directly from Online Shop
on our company’s website. Sales of accessories are different according to the country.

® USB connecting AC adapter: A514

DC5V AC adapter for USB connection

® 2 channel microphone
(omni-directional): ME3OW
Two ME30 monaural microphones come
in a set with a miniature tripod and a
connection adapter. These are highly
sensitive omni-directional microphones
supported by plug-in power which

® Connecting cord: KA333

Connecting cord which has stereo
mini-plugs (#3.5) with resistance at both
ends. Use to connect from the earphone
jack output of the recorder to the
microphone input jack when recording.
Converting plug adapters (PA331/PA231)
which convert to the monaural mini plug
(23.5) or monaural mini plug (22.5) are

are well-suited to recording musical al.so ?nclo'sed.
performances. @ Lithiumion battery: LI-50B

@ Compact Gun Microphone This lithium ion rechargeable battery
(unidirectional): ME31 is r_nanufgctured by Olympus. It is best
The directional microphones useful for paired with the LI-50C battery charger.
recordings such as outdoor recording of
wild birds singing. The metal-cut body
provides a sturdiness to the high rigidity.

@ Highly sensitive noise-

cancellation monaural

microphone (unidirectional):

ME52W

This microphoneis used to record sound at

a distance while minimizing surrounding

noise.

Tie clip microphone

(omni-directional): ME15

Small concealing microphone with a

tie-clip.

® Exclusive remote control set: RS30W

When the receiver is plugged into the

REMOTE jack the recorder’s recording and

stop functions can be operated through the

remote control. The receiving position can

be adjusted, thereby allowing you to operate

the recorder from various different angles.

® Telephone pickup: TP7
Earphone type microphone can be
plugged into your ear while phoning.
The voice or conversation over the phone
EN can be clearly recorded.
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Specifications

General points

Recording medium:

Built-in memory

DM-5:8 GB

DM-3:4 GB

microSD card (512 MB to 16 GB)
Recording format:

Linear PCM (Pulse Code Modulation)
MP3 (MPEG-1 Audio Layer3)

WMA (Windows Media Audio)
Input level:

[Mic Sense]:[Middle] - 60 dBv
Maximum working output:
280 mW (8 Q speaker)

Maximum headphone output:
=150 mV (according to EN 50332-2)
Wide band characteristic
headphone output:

75mV = (according to EN 50332-2)
Speaker:

Built-in 23 mm round dynamic speaker

B MICjack:

2 3.5 mm mini-jack, impedance 2.2 kQ

B EAR jack:

@ 3.5 mm mini-jack, impedance 8 Q or

more

Input power requirement:

Battery: Lithium ion battery

External power supply: AC adapter(A515)
5V

External dimensions:

113.6 mm x45.6 mm 15.2 mm

(without protrusions)

H Weight:

98 g (including battery)

B Operating temperature:

0°C-42°C

Overall frequency response

B During recording or playback
mode:
Linear PCM format

Overall frequency

Recording mode response

48 kHz 40 Hz to 23 kHz
44.1 kHz 40 Hz to 21 kHz
MP3 format
s Overall frequency
Recording mode response
320 kbps 40 Hz to 20 kHz
256 kbps 40 Hz to 20 kHz
192 kbps 40 Hz to 19 kHz
128 kbps 40 Hz to 17 kHz
WMA format

Overall frequency

Recording mode response

ST XQ 40 Hz to 19 kHz
STHQ 40 Hz to 16 kHz
ST SP 40 Hz to 9 kHz
HQ 40 Hz to 13 kHz
SP 40 Hz to 8 kHz
LP 40 Hz to 3 kHz

B Built-in stereo microphone
(During recording mode):
DM-5:70 Hz to 20 kHz
DM-3:70 Hz to 20 kHz

However, when recording by the MP3

format or the WMA format, the upper limit

value of the frequency response depends
on each recording mode (see above
diagram).
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Specifications

Guide to recording times

B Linear PCM format:

Recording Built-in Built-in microSD card
mode 7 J
| (4GB)(DM-3) | (8 GB)(DM-5) 1GB 2GB 4GB
48 kHz 5h.15min. 11h.05min. 1h.15min. | 2h.45min. | 5h.30min.
44.1 kHz 5h.45min. 12h.05min. 1h.20min. 3h. 6h.
H MP3 format:
A Built-in Built-in i
Recording microSD card
mode memoty memory 1GB 2GB 4GB
320 kbps 25h.30min. 53h. 6h.30min. | 13h.30min. 27h.
256 kbps 31h.30min. 66h.30min. 8h. 17h. 34h.
192 kbps 42h.30min. 89h. 11h. 23h. 45h.
128 kbps 63h.30min. 133h. 16h.30min. 34h. 68h.
H WMA format:
Recording Built-in Built-in microSD card
mode memory BN DMS) 1GB 2GB 4GB
ST XQ 62h.30min. 130h. 16h. 33h. 66h.
STHQ 125h 261h. 32h. 67h. 133h.
STSP 250h. 522h. 65h. 135h. 266h.
HQ 250h. 522h. 65h. 135h. 266h.
SP 492h. 1029h. 128h. 267h. 524h.
LP 977h. 2043h. 255h. 531h. 1042h.

+ The above values are strictly rough guides.
« Variationsin the available recording time will arise as there may be differences in the available
memory depending on the microSD card.
» Caution is required, since the differences in the available recording time will increase when
the bit count and bit rate are low.
- Available recording time may be shorter if many short recordings are made (The displayed
available recording time and recorded time are approximate indications).



Specifications

Maximum recording time per file

B Linear PCM format: B WMA format:
48 kHz 3h. ST XQ 72h.50min.
44.1 kHz 3h.20min. STHQ 145h.40min.
B MP3 format: ST SP 291h.30min.
- HQ 291h.30min.
320kbps 29h.40min.
X SP 574h.
256kbps 37h.10min.
N LP 1139h.20min.
192kbps 49h.40min.
128kbps 74h.30min.

+ The maximum capacity for a single file is limited to approx. 4 GB for WMA and MP3.
« The size limit for a file in the Linear PCM format is approx. 2 GB.

Guide to battery life

B Lithium ion battery:

Built-in stereo Built-in
A microphone speakers
Recording mode (During recording (During playback Earphone Playback
mode) mode)

PCM 48kHz 13h. 12h. 20h.
MP3 128kbps 25h. 12h.30min. 20h.
STXQ 24h. 12h.30min. 21h.
LP 29h. 13h. 22h.

suonexynads E

+ The above values are strictly rough guides.
Battery life is measured by Olympus. It varies greatly according to the type of battery used
and the conditions of use.

Specifications and design are subject to
change without notice.
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Technical assistance and support

The following are contact information for technical support for Olympus recorders and
software only.
® Technical Hotline Number in the U.S. and Canada
1-888-553-4448
® User Support E-mail address in the U.S. and Canada
distec@olympus.com
® Technical Hotline Number in Europe
Toll free number: 00800 67 10 83 00
available for Austria, Belgium, Denmark, Finland, France, Germany, Italy, Luxemburg,
Netherlands, Norway, Portugal, Spain, Sweden, Switzerland, United Kingdom
Charged numbers for the Rest of Europe
+49 180567 1083
+ 494023773 4899
User Support E-mail address in Europe
dss.support@olympus-europa.com

For customers in Europe

“CE" mark indicates that this product complies with the European requirements for safety,
health,environment and customer protection.

This symbol [crossed-out wheeled bin WEEE Annex IV] indicates separate collection of waste electrical and
electronic equipment in the EU countries. Please do not throw the equipment into the domestic refuse.
Please use the return and collection systems available in your country for the disposal of this product.
Applicable Product : DM-5/DM-3, AC adapter

This symbol [crossed-out wheeled bin Directive 2006/66/EC Annex II] indicates separate collection of
waste batteries in the EU countries. Please do not throw the batteries into the domestic refuse. Please use
the return and collection systems available in your country for the disposal of the waste batteries.
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OLYMPUS

OLYMPUS IMAGING CORP.
Shinjuku Monolith, 3-1 Nishi-Shinjuku 2-chome, Shinjyuku-ku, Tokyo 163-0914, Japan. Tel. +81 (0)3-3340-2111
http://www.olympus.com

OLYMPUS IMAGING AMERICA INC.
3500 Corporate Parkway, P.O. Box 610, Center Valley, PA 18034-0610, U.S.A. Tel. 1-888-553-4448
http://www.olympusamerica.com

OLYMPUS EUROPA HOLDING GMBH
(Premises/Goods delivery) Wendenstrasse 14-18, 20097 Hamburg, Germany. Tel. +49 (0)40-237730
(Letters) Postfach 10 49 08. 20034 Hamburg, Germany.
http://www.olympus-europa.com
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